
Style Guide

Version 6.0

REFERENCE GUIDE

For Internal Use Only



© 2009–2025 Fair Isaac Corporation. All rights reserved. This documentation is the confidential,
proprietary, and unpublished property of Fair Isaac Corporation ("FICO"). Receipt or possession of
this documentation does not convey rights to disclose, reproduce, make derivative works, use, or
allow others to use it except as set forth in a written software license agreement between you and
FICO (or a FICO affiliate). Use of this documentation and the software described in it must conform
strictly to the license agreement.

The information in this documentation is subject to change without notice. If you find any problems in
this documentation, please report them to us in writing. Neither FICO nor its affiliates warrant that
this documentation is error-free, nor are there any other warranties with respect to the documentation
except as may be provided in the license agreement. FICO and its affiliates specifically disclaim any
warranties, express or implied, including, but not limited to, non-infringement, merchantability and
fitness for a particular purpose. Portions of this documentation and the software described in it may
contain copyright of various authors and may be licensed under certain third-party licenses identified
in the software, documentation, or both.

In no event shall FICO or its affiliates be liable to any person for direct, indirect, special, incidental, or
consequential damages, including lost profits, arising out of the use of this documentation or the
software described in it, even if FICO or its affiliates have been advised of the possibility of such
damage. FICO and its affiliates have no obligation to provide maintenance, support, updates,
enhancements, or modifications except as required to licensed users under a license agreement.

FICO and Fair Isaac Other product and company names herein may be trademarks of their
respective owners.

Patent(s): www.fico.com/en/patents

Reference Guide Version 6.0

Deliverable Version: A

Last Revised: August 31, 2025

https://www.fico.com/en/patents


Contents

Chapter 1: 
Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Chapter 2: 
General Principles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Accessibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9
Active Voice . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Copyrights and Trademarks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Customer Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Error Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Writing for Localization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Spelling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Third-Party Content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Timelessness . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Tone . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Chapter 3: 
Language and Grammar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18

Abbreviations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Anthropomorphisms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Articles (a, an, the) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Capitalization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Context . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Contractions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23
Gerunds . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23
Plurals in Parentheses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Possessives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .24
Prepositions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25
Pronouns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Relative Pronouns (That, Which) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Verb Tense . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Fair Isaac Corporation Confidential and Proprietary Information 3



Chapter 4: 
Punctuation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Colons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Commas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Dashes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Ellipses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
End Punctuation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .35
Exclamation Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Hyphens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Parentheses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37
Question Marks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Quotation Marks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38
Semicolons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Slashes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Chapter 5: 
Format and Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Captions (Titles) for Figures and Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .42
Cross-References . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .43
Dates and Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .46
Footnotes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Graphics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Italicized Words . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Keystrokes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .48
Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .52
Numbers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Paragraphs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Short Descriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Titles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Chapter 6: 
User Interfaces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Main UI Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Dialog and Page Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Verb Syntax for UI Interactions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Prepositions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .77
Mock UI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

Contents

Fair Isaac Corporation Confidential and Proprietary Information 4



Chapter 7: 
Specialty Chapters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

Addenda . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Parts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .81

Database Descriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Standard Attributes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Standard Columns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
Items That Are No Longer Used . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
Common Entity Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
Using Examples in Entity Descriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
Common Attribute Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Using Examples in Attribute Descriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
Common Domain (Domain and Domain Global Documentation) . . . . . . . . . . . . . . . . . . . . . . . 96

Troubleshooting Topics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .97
Release Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

Guidelines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .98
What to Avoid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

Example 1: Sections for Multiple New Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .101
Example 2: Bulleted List of Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Example 3: Upgrade Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Example 4: Issues/Workarounds in KBAs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Example 5: Deprecation Notices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Example 6: See Also Notes in Release Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

Q&A . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
Frequently Asked Questions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104

FAQ Stuctures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .104
Indexes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

Creating Index Entries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
Abbreviations and Acronyms in Indexes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Plural vs. Singular . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .108
Capitalization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Prepositions and Articles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Verbs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

Index Entries and Levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Primary Entries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Use of Adjectives in Primary Entries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
Over-indexing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
Under-indexing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
Sorting Secondary Entries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
Avoiding Redundant Secondary Entries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111

Cross-references in Indexes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111

Contents

Fair Isaac Corporation Confidential and Proprietary Information 5



Using a See Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
Using a See Also Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112

Testing the Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
Glossaries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

Chapter 8: 
Word Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

Technical Terms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Preferred Terms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

Above, Below, Beneath . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
Allow, Let, Permit, Enable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .118
And/Or . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
Appears, Displays, Opens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
Champion/Challenger, Champion-Challenger . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .119
Choose, Click, Select . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
CLASSPATH, classpath . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120
Complete, Perform . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .120
Comprise, Compose . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120
Configuring, Defining, Mapping, Setting Up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
Creating, Modifying, Editing, Updating . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .121
Delete, Remove . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .121
Directory, Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
Earlier, Previous, Later (Release Versions) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
Get, Obtain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
Help, Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .123
Hence, Thus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
In Which, Where . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
Indicates, Specifies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
Latin Abbreviations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
Launch, Start . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .125
Lower, Higher, Older, Newer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Multi-tenant, Multi-tenancy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Once, After . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Out-of-the-box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Previous, Preceding, Following, Next . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Prompt . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
Right-click Anywhere in the White Space . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .126
Since, Because . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
Use, Utilize . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
Validate, Test . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
ZIP Code, Postal Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .128

Prohibited Terms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

Contents

Fair Isaac Corporation Confidential and Proprietary Information 6



Appendix A: 
Revision History . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

Contents

Fair Isaac Corporation Confidential and Proprietary Information 7



Chapter 1

Introduction

Follow the editorial guidelines in this guide to help you document all FICO products
clearly and consistently.

For the FICO Technical Publications team, these guidelines are the house style, which
is driven by accessibility, localization, and usability best practices. Writers have
permission to depart from the house style if doing so is required for a specific product or
if doing so improves the content.

The goal of this guide is to provide concise answers to the most frequently asked style
questions rather than to provide an unabridged catalog of every convention used by the
department.

For style questions not answered in this style guide, consult the following resources.

Information Type Resource

DITA guidelines DITA Authoring Guide)

Spelling Merriam-Webster Dictionary

Style Microsoft Writing Style Guide
Google Developer's Style Guide

General word usage N-Gram Viewer - An interactive tool that lets you search for and compare
terminology trends (such as "email" versus "e-mail") in books and other text
sources over time

APIs "API Reference Code Comments" in the Google Developer's Style Guide

Other tech writing
resources

Write the Docs (best practices for release notes, APIs, CLIs, FAQs, and more)

For more help, feel free to contact the Style Committee.
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Chapter 2

General Principles

The following guidelines establish the overall principles that apply to the documentation
created by the FICO Technical Publications team.

Accessibility
Products are considered to be accessible if they are usable and understandable by all
users, including those with visual, auditory, motor, cognitive, and other disabilities.

Accessible documentation involves structuring, formatting, and presenting information
so all readers (including those with disabilities) can effectively interact with it. While
most (but not all) of our FICO products are coded to comply with accessibility standards,
the Technical Publications team has no accessibility requirements for our
documentation.

We might develop accessibility requirements for our documentation in the future, but in
the meantime, writers can watch for opportunities to help their teams improve the
accessibility of the products that they support.

General accessibility guidelines for user interfaces (UIs):

■ Icons are clearly labeled or are identified by flyover help.

■ Users are able to navigate the entire UI using keyboard strokes (without a mouse or
trackpad).

■ Navigation follows a clear task flow and hierarchy of importance.

■ Fonts are formatted in a simple, uncomplicated way. (Formatting can prevent
screen readers from explicitly describing UI text.)

■ Color, size, location, and other visual cues are not used as the sole way of
communicating information.
If color, icons, or outline thickness are used to convey an active state, a secondary
cue, such as a change in the text label, is also used.

■ Consideration is given to using a toggle to active accessibility features (such as
percentage progress bars and ASCII box rendering).

■ UI text avoids camel case and all-cap formatting. (Some screen readers read
capitalized letters individually.)

■ UI text can be correctly understood without punctuation marks. (Sometimes screen
readers do not read punctuation.)

■ Exclamation marks, question marks, and semicolons are not used.
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■ Ampersands (&) are only used where space is an issue in tables or diagrams. (The
use of ampersands in code is acceptable.)

■ When non-user-initiated actions are executed (such as a save operation that occurs
upon navigation away from the page), some sort of validation (such as a message
or change in icon) is used to alert users that a change occurred.

■ The ratio of color contrast between text and UI elements is at least 4.5-to-1.

For additional accessibility guidelines, see Accessibility (Google style guide) and
Accessibility by Material Design.

Considerations
While directional language (such as above, below, left, right) and colored text might help
visual users, neither one is helpful from an accessibility perspective.

■ Directional language. We generally limit the directional language in our instructions
to preceding and following, but if UI elements are unlabeled or complicated to find,
users might need more help. For example, in the following busy screen, users might
have difficulty locating the Send Notice icon.

Chapter 2: General Principles
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Use: To set up customer emails, click the Send Notice icon in the right corner of the
Written Communication tile.
Avoid: Use the right tile to set up email notices to customers.

■ Colored text. Avoid references to colors.
Use: To work with cases, go to the My Activities pane in the Case Manager Home
page, then click Open Case.
Avoid: The green-colored My Activities pane on the Case Manager Home page
provides an Open Case button that you can use to work with cases and access the
system administration navigation pane.

Active Voice
Voice can be active or passive.

■ In active voice, the subject (or actor) of the sentence (such as the reader, a
computer, or a server) clearly performs the action (the verb) of the sentence.

■ In passive voice, the actor is unknown. The subject of the sentence receives the
action.

Prefer active voice, especially to clarify in steps and instructions where the reader
needs to do something. Use passive voice sparingly and intentionally.

Chapter 2: General Principles
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Voice Uses Examples

Active For procedures and most other
content.

■ Send a query to the service.

■ The server sends an
acknowledgment in response.

Passive To avoid sounding condescending
or blaming readers, especially in
error messages, warnings, and
notifications.
To avoid awkward sentence
construction.
To emphasize the receiver of the
action or the lack of actor.

■ A query is sent to the service.

■ The service is queried and an
acknowledgment is sent in
response.

Copyrights and Trademarks
Use copyrights and trademarks carefully to protect FICO's branding. Copyrights protect
original works of authorship (our user guides), while trademarks protect brands (our
company name and products). In general, copyright and trademark symbols for our
products are defined as DITA variables or set up in the boilerplate copyright page that is
maintained by committee. For instructions, see "Inserting Intellectual Property Symbols"
in the DITA Authoring Guide.

Our guidelines are based on the following documents by the Global Marketing
Department that provide company-wide guidelines for all types of FICO documentation:

■ FICO® Naming Protocol (subject to change)

■ FICO® Trademarks and Usage Guidelines

Copyrights
All product-related content that is created by the Technical Publications team at FICO is
legally copyrighted. The official statement in our deliverables is a boilerplate topic that is
maintained by the Process committee. The copyright statement uses the following
guidelines:

■ In copyright statements, do not use superscript for the copyright symbol.

■ Add a space before and after the copyright symbol.

■ Follow the copyright symbol with the year of publication or, for continuously updated
deliverable, a range of years that includes the first year of publication and the
current year.
Use: Copyright © 2014–2026 Fair Isaac Corporation
Use: Copyright © 2012, 2015–2026 Fair Isaac Corporation
(for gaps in a range)

Chapter 2: General Principles
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Trademarks
Even though the trademark symbol is only applied to "FICO" in our product names, our
Legal team requires us to treat our product names as trademarked. This means that the
following rules apply to our products.

Tip: For a list of official product names, see FICO Trademarks and Usage
Guidelines, which is maintained by the Marketing team. Refer to this document
periodically to check for updates. For example, "FICO Analytic Cloud" was recently
changed to "FICO cloud."

■ Use the fully trademarked product name on the cover page of each deliverable and
at the first mention of the product name in the body of a deliverable.

- Exception: A trademark symbol is not required for the phrase "Powered by FICO
Platform" when it follows a solution name that includes "FICO," such as {Varref:
FINameTrademarked}FICO® Originations Solution, Powered by FICO Platform.

■ Use the fully trademarked product name at the first mention in every topic. As a
best practice, avoid using the product name as much as possible.

■ Try to avoid using product names in headings and titles to help reduce the
appearance of trademarks in tables of contents.

■ When a product name occurs multiple times a topic, it is acceptable to drop "FICO"
and the trademark symbol after the first use.

- Exception: Never remove "FICO" or the trademark from FICO® Score or other
scoring products.

■ Always superscript registered trademarks® and trademarks™.

■ Omit spaces before trademarks symbols.

■ Never modify trademarked names with hyphenations, abbreviations, or plurals.
Use: The architecture specific to Blaze Advisor...
Avoid: Blaze Advisor-specific architecture...

Special Cases for Trademarks
■ Every reference to FICO® Score and other scoring products must always be

trademarked:

- FICO® Score

- FICO® Insurance Score

- FICO® Bankruptcy Score

■ When referring to FICO as a company (rather than as part of a trademarked product
or in a logo), no trademark symbol is required.
Use: FICO is the leader in decision management.

■ Do not make trademarked product names possessive.
Use: The Blaze Advisor system’s open architecture
Use: The open architecture of Blaze Advisor
Avoid: Blaze Advisor’s open architecture

Chapter 2: General Principles
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■ As a company name, FICO can be possessive.
Use: FICO’s headquarters are in Bozeman, Montana.

■ Never use acronyms to abbreviate trademarked product names unless the acronym
has also been trademarked. For example, abbreviating Application Fraud Manager
to "AFM" is not allowed, but abbreviating Small Business Scoring ServiceSM is
allowed because the acronym "SBSSSM" is trademarked.

Third-Party Trademarks
The trademarking of third-party (non-FICO) products is covered by the last sentence of
our copyright statement, which states Other product and company names herein may be
trademarks of their respective owners.

Exception: If FICO has a special agreement with a third-party, trademark symbols might
be required. Consult your product manager.

If you refer to a third-party product, follow the trademark requirements of the company
that owns the product. For example, according to Microsoft's Trademark Usage, they
only require that we use "Microsoft" before their product names. No trademark symbols
are required.

■ Use: Open the CSV file in Microsoft Excel.

■ Avoid: Open the CSV file in Excel.

■ Avoid: Open the CSV file in Microsoft® Excel.

Service Marks
In general, avoid using service marks, which identify services rather than goods. Service
marks are used mostly outside the U.S. and do not apply to FICO except for one
product.

Customer Support
Use the term "FICO Customer Support" for all references to our support team for
customers.

Avoid "Customer Support" (without "FICO") or any other variation.

Error Messages
For the standards that apply to writing error messages, see Error Messages Standards. 

Writing for Localization
The guidelines for localization have been incorporated throughout this style guide.

For additional guidance, see Internationalization (i18n) - Architecture and Technology
Strategy on Confluence.
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Spelling
Use American spelling (for example, color, authorize) rather than British spelling (for
example, colour, authorise, etc.).

Third-Party Content
The mention of third-party companies is sometimes required (such as a discussion of
supported browsers) but avoid mentioning third-party companies and content in
examples or hypothetical situations.

Avoid copying content from the following sources unless you are sure that FICO owns
the asset:

■ Third-party documents, websites, books, blogs, videos, images, or podcasts

■ Dictionaries, encyclopedias, and Wikipedia

■ Open-source product documentation

■ GitHub documentation

Important: Do not copy content from other sources (text, images, code, logos)
because doing so might violate a copyright. Instead, paraphrase or link to the
content.

■ Use: A recovery point objective (RPO) is the maximum acceptable length of
time during which data or transactions might be lost from your application due
to a major incident.

■ Avoid: Recovery Point Objective (RPO): "RPO is the maximum targeted period
in which data (transactions) might be lost from an IT service due to a major
incident" ( https://www.wikipedia.org/wiki/
Disaster_recovery#Recovery_Point_Objective).

Timelessness
In product guides, refer to the current version of a product or feature without anchoring
the documentation to a point in time or referring to prior knowledge. However, such
time-related content is acceptable in other types of documentation, such as press
releases, blog posts, and release notes.

Timeless documentation avoids words that can render documentation outdated,
accurate for a limited period of time, or meaningful only for a certain time. For example,
Scorecards is a new feature in Data Modeler is a statement that assumes prior
knowledge of the product and becomes outdated soon after publication. Such a
statement is acceptable in release notes, but not a product guide.

Document the Current State
For FICO user documentation, write about the current state and functionality of a
product at the time of release instead of discussing changes made since a previous
version or possible future development.

Chapter 2: General Principles
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Avoid pre-announcing or promising future features or products unless you secure the
specific approval of legal counsel.

Words and Phrases to Avoid
When describing product or feature capabilities in product and reference documentation,
avoid the following time-related words and phrases:

■ as of this writing

■ currently

■ does not yet

■ eventually

■ existing

■ future, in the future

■ latest

■ new, newer

■ now

■ old, older

■ presently, at present

■ soon

For guidance about how to write release notes, see Release Note Standards.

Tone
In our UX designs, the company follows (mostly) the FICO Brand Guidelines created by
Marketing.

See "Verbal Identity" (page 101) in the FICO Brand Guidelines. The notable exception
to the branding guidelines is that we use title case in top-level headings instead of
sentence case. For capitalization guidelines, see UX Standards.

We operate in the Fintech industry, which leans toward structured and professional
language. We communicate to a wide variety of stakeholders, from C-suite executives
and tech managers to staffers and fellow employees, so even though we communicate
formally, our FICO brand is "human, bold, clear, and precise." For that reason, our goal
is to use warm and engaging language that exudes confidence and technical savvy, but
without arrogance.

To summarize, use the following branding guidelines for external FICO documentation:

■ Use plain English.

■ Be concise and use fewer words to tell the story.

■ Convey warmth and engagement, using active language.

■ Avoid jargon, but where it is unavoidable, translate it.

■ Avoid humor and casual banter.

Chapter 2: General Principles
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The branding guidelines also contain a helpful (although brief) word list that we follow.
See page 113 of the FICO Brand Guidelines.
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Chapter 3

Language and Grammar

The following guidelines establish the language and grammar conventions used in the
documentation created by the FICO Technical Publications team.

Abbreviations
The term abbreviation in this guide includes acronyms, initialisms, and shortened words.

Spell out abbreviated terms on first mention in the body text, followed with the
abbreviation in parentheses. For subsequent mentions of an abbreviated term, use only
the abbreviation.

■ Use: The TRIAD PC Table Maintenance System (PCTMS) provides the following:

Exception: In database reference guides, certain values must appear first as
abbreviations, followed by the full term in parentheses.

■ Use: The format being submitted is FFF (Full File Fixed).

Do not use acronyms in parentheses in headers or titles.

■ Use: Create a Rule Maintenance Application

■ Avoid: Create a Rule Maintenance Application (RMA)

Spelled-Out Abbreviations
Capitalize spelled-out terms only when they are a proper noun or are conventionally
capitalized. Even though an abbreviation is all uppercase, the spelled-out term is often
lowercase. When in question, consult the Corporate Glossary or a dictionary.

■ Use: The predictive value is based on the weight of evidence (WoE).

■ Avoid: The predictive value is based on the Weight of Evidence (WoE).

■ Use: An application service provider (ASP) provides online software.

■ Avoid: An Application Service Provider (ASP) provides online software.
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File Extensions
Use lowercase for file extensions when referring to a specific file.

■ Use: Save the Revision.fm file and commit your changes.

Use all uppercase for standalone file extensions such as PDF, RTF, and DLL. Do not
include a preceding period.

■ Use: A ZIP file is created with the BIM file in the root and the DAT file in the
client_resources subdirectory.

■ Avoid: A .ZIP file is created with the .BIM file in the root and the .DAT file in the
client_resources subdirectory.

Latin Abbreviations
Latin abbreviations are often confusing to readers and cause difficulties for localization.
Avoid Latin abbreviations except to save space in tables and images.

■ Instead of e.g., use for example.

■ Instead of i.e., use that is.

■ Instead of vs or vs., use versus.

■ Instead of via to mean by way of, use by or using.
Exception: The use of via is acceptable in relation to transportation.

■ Instead of vice versa or vice-versa, find another word or phrase.

■ Instead of etc., rewrite the sentence or use such as, and so forth, or and so on.

Tip: Do not include for example and and so forth in the same phrase because
they are redundant.

In Indexes
Create separate index entries for acronyms and their spelled-out terms. Decide which
one is preferred, then cross-reference the less preferred term to the preferred term.

Use Avoid

In Trademarks
Do not use acronyms to abbreviate trademarked product names unless the acronym is
also trademarked.
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For example, abbreviating "Application Fraud Manager" to "AFM" is not allowed, but
using "SBSSSM" for "Small Business Scoring ServiceSM" is allowed because the
abbreviation is trademarked.

Anthropomorphisms
Do not attribute human traits, actions, or ownership to inanimate objects (such as files,
software, hardware, or systems). Avoid stating that inanimate objects can possess
something.

■ Use: Enter the file name.

■ Use: Enter the name of the file.

■ Avoid: Enter the file's name.

Be careful when using verbs like experience, see, tell, aim, guard, prefer, notice, agree,
decide and other human qualities.

■ Use: The delimiter object specifies where to split a string.

■ Avoid: The delimiter object tells where to split a string.

Articles (a, an, the)
For maximum comprehension and ease of translation, include articles (a, an, and the) in
your user documentation and system messages.

Articles help readers and translation software identify the nouns and modifiers in a
sentence. The choice of articles can change the meaning of a sentence.

■ The articles a and an (indefinite articles) refer to a group as a whole.
"A support bundle includes the proper settings" means that all support bundles in
general include the proper settings. You can also eliminate the article: "Support
bundles include the proper settings."

■ The article the (definite article) refers to a specific member of a group.
"The support bundle includes the proper settings" refers to the contents of the
specific bundle that is being used rather than to bundles in general.

Do not refer to the user.

■ Use: Copy the folder to your home directory.

■ Avoid: Copy the folder to the user's home directory.

■ Use: Options for filtering the content are available.

■ Avoid: The user will have options for filtering the content.

When referring to FICO products, do not precede the names of products with an article.

■ Use: FICO Platform spans the applied intelligence value chain.

■ Avoid: The FICO Platform spans the applied intelligence value chain.
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When referring to FICO documentation, using the before a title is acceptable.

■ Use: See the FICO Platform - Core Services user guide.

■ Use: See FICO Platform - Core Services.

■ Avoid: See FICO Platform - Core Services user guide.

Capitalization
To standardize capitalization in FICO documentation, use the following guidelines.

In general, avoid unnecessary capitalization in body text.

■ Capitalize words only as required for titles, proper nouns, and abbreviations.

Tip: Software features are not proper nouns. Do not capitalize them in body
text. If you need to cite them in instructions, match the capitalization in the UI.

■ Avoid capitalizing all of the letters in a word unless it is an official name, an
abbreviation, or when referring to code that uses all capital letters.

■ For hyphenated terms in titles and headings, capitalize the second word when it is a
proper noun or when that second word would be capitalized in title case as a
standalone word.
For example:

- Run-in Heading (in would not be capitalized as a standalone word in title case, so
it is not capitalized after a hyphen)

- How-to Instructions (to would not be capitalized as a standalone word in title case,
so it is not capitalized after a hyphen)

- Post-Authorization Management (authorization would be capitalized as a
standalone word in title case, so it is capitalized after a hyphen)

- Multi-Target Settings (target would be capitalized as a standalone word in title
case, so it is capitalized after a hyphen)

■ In body text, do not capitalize a noun that follows a proper noun, such as the name
of a model, report, or UI element.

- Use: Open the Fraud Predictor model.

- Avoid: Open the Fraud Predictor Model.

- Use: Open the Statistics Summary tab.

- Avoid: Open the Statistics Summary Tab.

■ For trademarked or copyrighted material, such as dBase and UNIX, capitalize
according to the proprietary spelling.

■ Do not capitalize words for emphasis. Use italics instead.

■ Avoid camel case in body text and titles (for example, codeName) except for official
names (such as dBase) and when referring to code that is written in camel case.
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Capitalization in Titles
Use title case for all levels of headings (H1 through H8).

In user interfaces, both title case and sentence case are used. For guidelines, see User
Interfaces.

Rules for Title Case

Always capitalize the following words in title case:

■ The first and last words of all titles, regardless of their part of speech

■ Verbs of any length (including Be, Are, Is, See, Add)

■ Nouns of any length

■ Words after a hyphen if that word would be capitalized as a standalone word in title
case (for example, Self-Test, Platform-Related)

■ The conjunctions Nor, Yet, So

■ The prepositions Up, Off, and Out, and all prepositions with more than three letters
(With, Through, Before)

Do not capitalize the following words in title case:

■ Articles (a, an, the) unless they are the first word of the title

■ The conjunctions for, and, but, or, as, and if

■ Prepositions with two or three letters (to, for, at, on, by, in, out), unless they are the
first or last word of the title

For example:

■ Scorecards With Auto-Constraints

■ Save and Rebin

■ The Rules for Logging In

■ Functions as Invokable Assets

Tip: For help generating title case, go to https://titlecaseconverter.com. Type your
title into the converter field, then select New York Times style.

Rules for Sentence Case

Sentence case capitalizes only the first word of a sentence (aside from proper nouns
and such).

For example:

■ The document cannot be found.

■ Use this field to retrieve results from Nexus.
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Context
When writing instructions, start by mentioning the circumstance, condition, or goal
before giving the instruction. By setting the context before the instruction, readers can
decide whether they need to skip the instruction.

See Procedures on page 58.

■ Use: To delete the entire file, click Delete.

■ Avoid: Click Delete if you want to delete the entire file.

Contractions
FICO uses a semi-formal tone, so we avoid contractions in our user documentation,
user interfaces, and system messages.

See Tone for a link to FICO's official branding information.

Its and It's
Be careful to avoid confusing its (possessive) with it's (noun + verb).

Never use its' (with the apostrophe after the s) because it is not a valid word.

Gerunds
Use gerunds sparingly and intentionally.

Gerunds are verbs ending in -ing that act as nouns. Because gerunds can act as a
subject, a direct object, a subjective complement, or an appositive, they tend to erode
clarity and are difficult to translate. Rewrite if possible.

■ Use: When you refer to a node, match the capitalization.

■ Use: To refer to a node, match the capitalization.

■ Avoid: When you are referring to a node, match the capitalization.

■ Use: To view a notebook description, click Notebook.

■ Avoid: View a notebook description by clicking Notebook.

For guidance with gerunds in topic titles, see Titles.
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Plurals in Parentheses
Avoid using (s) to express an optional plural. This convention is especially important if
your content is localized.

Instead, use plural or singular constructions, depending on which one is the most
appropriate for your documentation and your audience. Consider using one or more.

■ Use: To find your API key, go to the Credentials page.

■ Avoid: To find your API key(s), go to the Credentials page.

■ Use: The value of the parent depends on the values of its children.

■ Avoid: The value of the parent depends on the value(s) of its child(ren).

Possessives
In general, try to avoid possessives in user documentation, especially when doing so
creates an anthopomorphism.

For possessives, add 's to the end of singular and plural nouns that do not already end
in s. For plural nouns that end in s, add an apostrophe but no additional s:

■ alias's, not aliases's

■ women's, not womens'

Possessive Pronouns
Do not use 's for possessive pronouns.

■ Use: its, yours, theirs, ours

■ Avoid: it's, your's, their's, our's

Product, Feature, and Company Names
Avoid writing the possessive form of a feature name, product name, or trademark
(regardless of who owns it). Instead, use the name as a modifier or rewrite the sentence
with a word like of to indicate relationship.

■ Use: Use this template to monitor search performance.

■ Use: Use this template to monitor the performance of search.

■ Avoid: Use this template to monitor search's performance.

To form the possessive of a company name, add 's to the end of the name. However, do
not use 's to make a company name possessive when it is part of a trademarked
product name. See Copyrights and Trademarks on page 12.

■ Use: FICO's new office is nearby.

■ Avoid: The capabilities of FICO's Platform are vast.
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Do not use 's in the titles of FICO guides.

■ Use: Product X User Guide

■ Avoid: Product X User's Guide

■ Use: Product X Administrator Guide

■ Avoid: Product X Administrator's Guide

Code Items
Do not form the possessive of code items (methods, values, objects). Either make the
noun that follows the code possessive, or rewrite the sentence to avoid the possessive
form.

■ Use: Compare the number to the value returned by the wordCount method.

■ Avoid: Compare the number to wordCount's return value.

Prepositions
Because our tone is semi-formal, try to avoid ending sentences with prepositions (in,
with, about, for, and others).

■ Use: …the database that contains the variable.

■ Avoid: …the database that the variable is in

■ Use: You can import the file during or after dataset creation. 

■ Avoid: You can import the file during the process of creating a dataset or after.

■ Use: The file is loaded into the system for which it was configured. 

■ Avoid: The file is loaded into the system that it was configured for.

However, it is acceptable to end a sentence with a preposition to avoid an awkward
rewrite.

■ Acceptable: Sorting is the purpose that the process is designed for.

■ Also acceptable but very formal: Sorting is the purpose for which the process is
designed.

If avoiding an ending preposition makes a sentence awkward, rewrite the sentence.

■ Use: I will not put up with bad grammar.

■ Avoid: Bad grammar is something I will not put up with.

■ Avoid: Bad grammar is something up with which I will not put. (Grammatically
correct but awkward.)

For a list of prepositions to use in relation to UI elements, see UI Elements.
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Prepositions to Break Up Noun Strings
Prepositions are helpful in clarifying long strings of nouns that might be interpreted
multiple ways. In the following "avoid" example, it is impossible to decipher whether the
connector, the connector manager, or the icon is blue.

■ Use: The blue icon for the connector manager turns green within a few minutes.

■ Avoid: The blue connector manager icon turns green within a few minutes.

Too Many Prepositions
Avoid using numerous prepositional phrases in a single sentence, even if the sentence
is grammatically correct. Long chains of prepositional phrases are hard to read and are
easy to misinterpret.

■ Use: A decision tree is a flowchart of nodes that represent populations that are
segmented according to variable condition and treatment.

■ Avoid: A decision tree is a graphical flowchart structure containing a set of decision
rules that map an observation to an appropriate action through easy segmentation
of a population, where each decision node represents a condition on a variable and
each end node (leaf node) has a treatment associated with it.

Pronouns
Pronouns help relieve the monotony of having to repeat nouns over and over, but they
can accidentally reduce the clarity of your writing unless you use them carefully.

Ensure that every pronoun (for example, it, they, or this) clearly replaces its antecedent
(the noun that it replaces). Avoid vague references and any chance that a pronoun
could refer to more than one noun.

■ Use: If you type text in the field, the text does not change.

■ Avoid: If you type text in the field, it does not change.

The Imperative You

When you tell readers to do something, use the imperative (the you is implied).

■ Use: Click Submit.

■ Avoid: The user clicks Submit.

First Person Pronouns

Avoid first-person pronouns (I, we, us, our, and ours) except in FAQs.

The pronoun (you) is allowed as long as you maintain a semi-formal tone.

The User Instead of You

Avoid using the phrase the user except in administrator guides when you need to
differentiate between the admin and the users of the technology being administered.

■ Use: After the target is selected, you can edit the target definition.

■ Avoid: After the target is selected, the user can edit the target definition.
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■ Use: The default template is used unless you specify another one.

■ Avoid: The default template is used unless the user specifies another one.

Vague References

It is best to follow a demonstrative pronoun (like this and these) with a noun to add
clarity.

■ Use: Set this value to true.

■ Avoid: Set this to true.

Gender Neutrality

Avoid using the gender-specific pronouns he, him, his, she, her, he/she, or (s)he.

Plural Pronouns
Avoid first-person plural pronouns (we, our, or us) to refer to an organization. Instead,
use FICO or the name of the organization.

■ Use: FICO provides X, but not Z.

■ Avoid: FICO provides X, but we do not provide Z.

■ Use: For help, contact FICO Customer Support.

■ Avoid: For help, contact our FICO Customer Support.

■ Use: FICO recommends the following best practice.

■ Avoid: We recommend the following best practice.

Relative Pronouns (That, Which)
Relative pronouns (that, which) are useful for avoiding ambiguity and adding clarity.
They are especially helpful for translators.

■ Use: Right-click the link that you want to open.

■ Avoid: Right-click the link you want to open.

■ Use: You can use other parameters, which are described in the following table.

■ Avoid: You can use other parameters, described in the following table.

That and which have different meanings and are not interchangeable.

■ That introduces a clause that cannot be removed without significantly changing the
meaning of a sentence (a restrictive clause). Do not use a comma before this type
of clause.
For example:
FSML files that include the equalTo condition can be imported to a decision tree.
This sentence means that only FSML files with a specific condition can be imported.
If the phrase that include the equalTo condition is removed, the meaning of the
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sentence changes to mean that all FSML files can be imported regardless of the
conditions they contain.

■ Which introduces a clause that can be removed without changing the meaning of
the sentence (a nonrestrictive clause). Always precede which with a comma.
For example:
FSML files, which include the equalTo condition, can be imported to a decision
tree.
This sentence means that all FSML files contain the equalTo condition, and that
they can all be imported. Removing the phrase which include the equalTo condition
does not change the meaning of the sentence.

For more information about when to use that or which, go to the Grammar Girl site.

Verb Tense
Present tense verbs are the best choice for user guides and release notes. Use present
tense verbs whenever possible.

■ Use: You can delete any source file that you upload.

■ Avoid: You can delete any source file that you uploaded.

Try to avoid using will or will be.

■ Use: The server sends an acknowledgment.

■ Avoid: The server will send an acknowledgment.

■ Avoid: An acknowledgment will be sent to the server.

Sometimes, of course, future tense is unavoidable but use it sparingly.

■ Use: These values will be lost if you delete the action.

Avoid the hypothetical future would:

■ Use: In this case, move the variable to the Variables Ignored list.

■ Avoid: In this case, you would move the variable to the Variables Ignored list.
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Chapter 4

Punctuation

The following punctuation is used at FICO. Refer to individual topics for examples and
additional details.

Punctuation 
Mark Comment More Information

Apostrophes ■ Avoid contractions.

■ Avoid the possessive form of trademarked
names.

■ The possessive form of company names is
allowed.

See Contractions.
See Possessives.

Colons ■ Use a colon after a phrase or sentence that
introduces a list.

■ Do not capitalize the first word after a colon
unless it is a proper noun or begins a full
sentence.

See Colons.

Commas ■ Use serial commas.

■ Use commas after introductory phrases and
to set off clauses.

■ Use commas to separate full sentences that
are joined by a conjunction.

See Commas.

Dashes ■ Avoid em dashes (—).

■ Use en dashes (–) without spaces for ranges
and negative numbers.

■ Use en dashes surrounded by spaces for
numeric timestamps, a minus sign, list items,
and the official name of FICO Platform
capabilities (FICO Platform – Decision
Trees).

See Dashes.

Ellipses ■ Avoid using except in code.

■ To refer to an icon or button in the UI, use
the phrase "ellipsis (...)" or the name of the
ellipsis (the More ellipsis (...)."

See Ellipses.
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Punctuation 
Mark Comment More Information

End punctuation ■ Avoid exclamation points, except in code
samples.

■ Use periods at the end of complete
sentences, followed by a single space.

■ Avoid using question marks except in UX
messages, FAQs, and code samples.

See End Punctuation.

Exclamation
points

■ Do not use except in code. See Exclamation Points.

Hyphens ■ Use to join multiple words that modify a noun
as a single unit or that cause confusion
without the hyphen.

■ Use to join two words that modify a noun if
one of the words is a present and past
participle (a verb used as an adjective or
noun) that ends in -ed or -ing).

■ Use for certain prefixes.

■ Use for compound numerals and fractions.

See Hyphens.

Parentheses ■ Use to enclose explanatory or non-essential
text.

See Parentheses.

Quotation marks ■ Avoid quotation marks except in code
samples.

■ Do not use quotation marks for emphasis.

■ Quotation marks are allowed around the
topic or chapter name in a reference to a
different publication.

See Quotation Marks.

Semicolons ■ Use a different form of punctuation whenever
possible.

■ Semicolons are acceptable before a
conjunctive adverb (when done correctly).

■ Semicolons are acceptable to separate a
series of complex items that contain their
own commas and conjunctions.

See Semicolons.

Slashes ■ Use sparingly, and only if unavoidable.

■ Avoid using and/or.

■ Do not place spaces around slashes.

See Slashes.
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Colons
Use colons to introduce vertical and serial (horizontal) lists. In technical writing, vertical
lists (both numbered and bulleted) are used much more frequently than serial lists
because vertical lists are easier to read and visually parse.

If the text before a colon is bold, do not make the colon bold unless it is part of a
heading.

See also: Lists.

Vertical Lists
Use a colon at the end of a phrase or sentence that introduces a list. If your content is
translated, try to avoid sentence fragments before the colon.

■ Use: The fields are defined as follows:

■ Use: To define the fields, complete the following steps:

■ Use: Field definitions:

Titles and Headings
If you must use a colon in a title or heading, follow the rules for capitalizing titles.
Always capitalize the first word that follows a colon in a title.

■ Use: Chapter 7: Models

■ Use: Getting Started: A Guide to Success

■ Avoid: Getting Started: a Guide to Success

UI References
If you refer to a UI element that is followed by a colon on-screen, do not include the
colon in the documentation.

Commas
Commas separate items in a series and separate certain types of clauses. Remember
that pauses in spoken language do not necessarily require a comma in writing.

Serial Commas
In a series of three or more items, use a comma (the Oxford comma) before the final
and or or to avoid potentially changing the meaning of the sentence.

Use: Locations are divided into zones, regions, and multi-regions.

Avoid: Locations are divided into zones, regions and multi-regions.
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Introductory Words and Phrases
Commas after introductory words or phrases can add clarity, but they are not always
required.

■ Commas are optional after simple introductory phrases of fewer than four words.
Both of the following examples are acceptable:
Use: Before the export you can edit the file.
Use: Before the export, you can edit the file.

■ Commas are required after longer phrases and clauses.
Use: Because every kernel requires memory, resources can be heavily impacted.

■ Commas are not needed after phrases that are restrictive (essential to the meaning
of the sentence).
Use: Only groups that contain parameters predefined in the model appear in this
list.
Avoid: Only groups, that contain parameters predefined in the model, appear in this
list.

■ Avoid using a comma between a subject and its verb.
Use: Completing the export as soon as possible is the goal.
Avoid: Completing the export as soon as possible, is the goal.

Connect Full Sentences
When a conjunction (and, but, or, nor, for, so, yet) separates two complete sentences,
insert a comma before the conjunction.

Use: System administrators must regularly delete temporary files, and users must
remove their downloaded files quarterly.

Avoid: System administrators must regularly delete temporary files and users must
remove their downloaded files quarterly.

Omit the comma when two verbs that are connected by a conjunction apply to a single
subject. In this case, the phrase after the conjunction is not a full sentence.

Use: Direct-access flags are plain variables and can be read directly.

Avoid: Direct-access flags are plain variables, and can be read directly.

Set Off Clauses
Set off certain types of clauses with a comma for clarity:

■ Use a comma before the word which at the start of a non-restrictive clause. See
Relative Pronouns.

■ Use a comma after conjunctive adverbs (otherwise, however, or therefore) that are
preceded by a semicolon.
Use: The variable must have a value; otherwise, the server returns an error.
Avoid: The variable must have a value otherwise the server returns an error.
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■ Use a comma before such as and for example.
Use: Enter an instance name, such as my_instance_99.
Avoid: Enter an instance name such as, my_instance_99.

■ Avoid using a comma before because unless it is used at the start of a non-
restrictive clause.
Use: You can use the same key name because each set of keys is independent.
Avoid: You can use the same key name, because each set of keys is independent.

Serial Adjectives
Although technical writing generally avoids the overuse of adjectives, sometimes
multiple adjectives are required to modify a single noun.

■ Use a comma between coordinate adjectives that describe a single noun equally.
You can rearrange coordinate adjectives or place and between them without
changing the meaning of the sentence.
Use: Robust, predictive thresholds are dictated by priority level.
Use: Predictive, robust thresholds are dictated by priority level.
Use: Robust and predictive thresholds are dictated by priority level.

■ Do not use a comma between cumulative adjectives, which build on one another
and work together as a unit to modify a single noun.
Use: The sample is too small for a separate hold-out set.

Tip: Cumulative adjectives appear in a specific order based on the following
categories: quantity, opinion, size, age, shape, color, origin, material, and purpose.
Because the order is preset, no commas are needed. The mnemonic Q-O-S-A-S-C-
O-M-P can help you remember the order.

The following phrase illustrates that changing the order of adjectives can make a
sentence nonsensical:

■ They saw three (quantity) incredible (opinion) enormous (size) eighteenth-
century (age) rectangular (shape) blue (color) Swiss (origin) pendulum
(material) clocks (purpose).
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Dashes
Dashes and hyphens are not interchangeable.

Em Dashes
Em dashes (—) interrupt the flow of a sentence for dramatic effect. Avoid using em
dashes because they can cause confusion and make translations unnecessarily difficult.

■ Avoid replacing em dashes with an en dash (the shorter dash) or a hyphen. Instead,
rewrite the sentence.
Use: The system supports features for logging, monitoring, and alerting.
Avoid: The system supports several features—including logging, monitoring, and
alerting.
Use: The new algorithm, which is complex, provides significant performance gains.
Avoid: The new algorithm—which is complex—provides significant performance
gains.

■ Avoid using em dashes in the following circumstances:

- To indicate an empty cell in a table

- To replace a bullet in a list

- To join words

En Dashes
Use an en dash (–) without spaces to indicate the following conventions:

■ A range of numbers or pages: 2015–2019

■ A range of dates: June 1–6

■ A range of time: 10:00 AM–2:00 PM (or use the word "to" as in 10:00 AM to 2:00
PM)

Use an en dash surrounded by spaces to indicate the following conventions:

■ Numeric times and dates in a timestamp: 2:15 PM ‒ 4:45 PM, or 2:15 PM 12/1/17 ‒
4:45 PM 4/1/18

■ An official FICO Platform service or capability: FICO Platform – Composability

Tip: For negative numbers, see Hyphens.

Dashes After Run-in Headings in Lists
It is acceptable to use an en dash surrounded by spaces to separate a bolded
introductory word or phrase in a bulleted list from its description. Colons or periods are
also acceptable. See Run-in Headings on page 69.
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Ellipses
An ellipsis (...) indicates the omission of information or a pause in thought. In general,
do not use ellipses when writing content, except to indicate omitted code.

In Content. When writing content, avoid using an ellipsis to indicate missing or assumed
information:

■ Use: Declare the object pattern (for example account1, account2, account3).

■ Avoid: Declare the object pattern (for example account1, account2, …).

■ Use: The system is automatically updated, ensuring optimal performance.

■ Avoid: The system is automatically updated ... ensuring optimal performance.

If the use of an ellipsis is unavoidable, type three periods without spaces, surrounded by
a space before the first period and a space after the last period.

In Product UIs. FICO developers sometimes use ellipses as labels for icons or buttons
with expandable menus. These ellipses can be horizontal (...) or vertical ( ). To refer to
an ellipsis in a UI, use the following guidelines:

■ Avoid using an inline image when referring to a horizontal ellipsis. It is acceptable to
use an inline image for a vertical ellipsis.

■ Use the term ellipsis rather than meatball menu, kebab, three dots menu, or some
other metaphor.

■ Always follow the term ellipsis with "(...)" rather than menu, link, or button:
Use: Click the ellipsis (...), then select xxx.
Avoid: Click the ... menu, then select xxx.

■ If the UI assigns a name or tooltip to an ellipsis (such as More, Options, or
Actions), refer to the ellipsis by name:
Use: Click the More ellipsis (...), then select xxx.
Avoid: Click the Action ... for the solution, then select Import.

End Punctuation
End punctuation is used to conclude a sentence or phrase.

Exclamation Points
Do not use exclamation points, except in code samples.

Periods
End complete sentences with a period followed by a single space.

Avoid using periods at the end of titles and headings.

Use: Install IBM OS-300 or AS/400

Avoid: Install IBM OS-300 or AS/400.
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Question Marks
Avoid using question marks at the end of sentences and in column headings whenever
possible.

Use: Install IBM OS-300 or AS/400

Avoid: Install IBM OS-300 or AS/400?

Question marks are allowed in UX messages, FAQs, and code samples.

■ Use: Save your changes?

■ Use: How can I generate a chain-of-custody token?

■ Use: [I 12:16:32.395 NotebookApp] or http://127.0.0.1:8888/?
token=myToken

Exclamation Points
Avoid using exclamation points except as part of a code example.

Hyphens
The hyphen (-) joins words for clarity. Never use spaces before or after a hyphen
(except for serial modifiers). Hyphens are not interchangeable with en dashes. See
Dashes.

Modifiers
■ Before a noun. Hyphenate two- and three-word modifiers that express a single

thought (adjectival phrase) when they occur before a noun.
Use: decision-making process, profile-in-memory execution, a well-known algorithm

■ Following a noun. Do not hyphenate a modifier when it follows the noun it modifies.
Use: The logs are written in real time.
Use: The plan was well known.

■ Standalone adjectives. If two adjectives can modify a single noun independently, do
not use a hyphen between the adjectives.
Use: a new workspace instance
Avoid: a new-workspace instance

■ Adverbs. If the first word in a modifier is the word very or an adverb that ends in -ly,
do not use a hyphen.
Use: a highly graphical interface, a very fast backup
Avoid: a highly-graphical interface, a very-fast backup

■ Numerals and letters. Hyphenate numerals and single letters in modifiers.
Use: a 640-gigabyte file, the y-coordinate values
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Other numbers. Hyphenate ordinals in adjectives and numbers over ten at the
beginning of a sentence.
Use: first-row instance
Use: Twenty-one variables is the maximum.

■ Serial modifiers. When two or more modifiers share a common root term in a
series, use the term only once at the end. This is sometimes called a suspended
hyphen.
Use: left- or right-aligned text; one-, two-, or three-hour intervals

■ Participles. Hyphenate modifiers before nouns when one of the words is a present
or past participle (verbs that end in -ing, -ed, -t, -en, -n, or -d).
Use: an often-defined schema, a free-flowing format

Prefixes
In general, do not use a hyphen to separate prefixes from their root noun.

Use: metadata, preprocessing

Note: Some terms do not follow this guideline. First consult the FICO Corporate
Glossary. If the term is not found, consult the Merriam-Webster Dictionary.

Add a hyphen after a prefix only in the following circumstances:

■ The prefix is self or cross: self-managing, cross-region

■ The prefix ex means former: ex-employee

■ The noun is capitalized or a number: non-FICO, post-2021

■ The omitted hyphen creates confusion: re-create vs recreate, reform vs re-form

■ The prefix ends with the same letter as the beginning of the root word: re-enter,
non-native

Negative Numbers
Use a hyphen to express negative numbers in text and in equations.

■ Negative numbers: -79

■ A minus sign in an equation, surrounded by spaces: 12 - 3 = 9

Parentheses
Use parentheses to enclose explanatory or non-essential words, phrases, or sentences.
Content in parentheses usually clarifies or defines the text that it follows while allowing
the focus to remain on the main text. Try to avoid putting important information in
parentheses. For important information, use different punctuation.

If you use parentheses, keep the content brief.

Use: Enter a six-digit hex number (for example, 228B22), then click OK.

Use: Log in to Analytics Workbench Manager (formerly Workspace Manager).
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If you use parentheses around a complete sentence, put the end punctuation inside the
parentheses.

Question Marks

See End Punctuation.

Quotation Marks
Limit the use of quotation marks except in code examples.

■ If you must use the term “quotation mark” use quotation mark, not quote marks.

■ It is acceptable to use quotation marks to signal a word or phrase that is used in a
non-standard way.
Use: Some users refer to this workaround as the “double-click trick.”

■ For emphasis, prefer the use of italics because quotation marks can be easily
misinterpreted as saracasm. For example, We "fixed" the problem by ignoring it
suggests that the problem was not fixed at all.
For guidelines about italics, see Italicized Words.

Cross-References
Do not use quotation marks or italics for cross-reference links to another topic in the
same guide. Instead, use the DITA element without adding extra formatting.

To reference a topic or chapter in another guide (without a link), use quotation marks
(not italics) around the topic or chapter name, then use the DITA <cite> element for the
name of the guide.

Use: For more information, see "Security Settings" in the FICO® Platform - Instant Model
Execution Service On-Premises Administrator Guide.

Code Samples
Use quotation marks carefully in code samples. Do not substitute single quotation marks
for double quotation marks, or vice versa.

In developer documentation, use straight quotes for the following reasons:

■ Code requires straight marks, so it is simpler to use straight marks everywhere in
developer documentation than to use them in code but not in text.

■ When proofreading, it can be difficult to differentiate whether marks are straight or
curly.
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Semicolons
Because semicolons are so frequently misused and misinterpreted, avoid using them if
possible. Instead, use an alternate form of punctuation or rewrite the sentence.

Use: In a segmented scorecard, trees subdivide the total population, one at each leaf of
the tree.

Avoid: In a segmented scorecard, trees subdivide the total population; one at each leaf
of the tree.

Use a semicolon before a conjunctive adverb (for example, therefore or however) or a
phrase (for example, that is) that joins two independent clauses.

Use: Most categorical variables are string data types; however, they can also be
numeric data types.

Avoid: Most categorical variables are string data types, however, they can also be
numeric data types.

Semicolons are unavoidable when you need to separate a series of long or complex
items that contain their own commas and conjunctions. However, the better approach is
to format a complex series of items into a bulleted list.

The following example is acceptable but not recommended:

■ Avoid: Use this tutorial to learn how to construct an interface; implement both
single-document interface and multiple-document interface applications; implement
features that until now were considered difficult, such as printing, toolbars, scrolling,
splitter windows, print preview, and context-sensitive Help; and take advantage of
many built-in components of the class library.

Consider using the following format instead:

■ Use: This tutorial explains how to do the following:

- Construct an interface

- Implement both single-document interface and multiple-document interface
applications
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- Implement features that until now were considered difficult, such as printing,
toolbars, scrolling, splitter windows, print preview, and context-sensitive Help

- Take advantage of many built-in components of the class library

Slashes
Because slashes can add confusion and cause difficulty with translations, use slashes
sparingly and only when unavoidable.

Slashes are acceptable for the following elements:

■ URLs – Start with two forward slashes (//).
Use: https://example.com/document

■ File path separators – Use backslashes (\) in Windows and forward slashes in Mac
OS (/).
Use: C:\Users\<UserName>\Documents\file.pdf (for Windows)
Use: /Users/<UserName>/Documents/file.pdf (for Mac OS)

■ Code samples – Use backslashes (\), primarily.

■ Mathematical fractions and expressions – Use forward slashes.
Use: 6/3 = 2
Use: JavaScript expression /[a-zA-Z0-9]+/

■ For tables in database reference guides, slashes are allowed because of space
limitations.

To instruct users to enter a slash, include the spelled-out term (backslash or forward
slash) first, followed by the symbol in parentheses.

■ Use: Enter a backslash (\) to do xxx.

Certain terms and abbreviations that use forward slashes are industry standards, such
as client/server, CI/CD, and TCP/IP. The use of slashes in these terms is acceptable.
Be sure to use them consistently.

Avoid using slashes as a replacement for or. For example, do not use slashes to
indicate alternatives, preferences, ranges, dates, combinations of terms, or options.

■ Use: You can save or delete the log.

■ Avoid: You can save/delete the log.

■ Use: 2024–2025

■ Avoid: 2024/2025

And/Or
Avoid using and/or. Instead, determine whether the statement means both, one but not
both, or either one or both.

■ Use: The score is scaled to another variable and sample. (both)

■ Use: The score is scaled to another variable or sample. (one but not both)
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■ Use: The score is scaled to another variable or sample, or both. (either one or both)

■ Avoid: The score is scaled to another variable and/or sample.

Chapter 4: Punctuation

Fair Isaac Corporation Confidential and Proprietary Information 41



Chapter 5

Format and Structure

Consistency in formatting and structure enhances readability, supports usability, and
reinforces the professionalism of technical documentation.

The guidelines for format and structure are related to the components in our
documentation that ensure usability, organize content, support navigation, and define
semantics. Use these guidelines to ensure that content aligned with our documentation
principles.

Captions (Titles) for Figures and Tables
Captions for figures and tables are optional. They are applied using the <figure><title>
and <table><title> elements.

Captions are a convention most often used in academic documents to provide a unique
identifier for figures and tables in long documents. Since FICO publications are not
academic papers, captions are optional.

Captions are allowed in following situations:

■ A figure or table is referred to from multiple places in a publication.

■ The purpose of the figure or table needs to be explicitly stated to ensure clear
communication.

■ The findings, data trends, or contents of a figure or table are so complicated that a
long explanation separates it from its explanation.

■ The “continued…” statement is needed for long tables that span multiple pages.

Note: Avoid using figure or table captions in any kind of list.

If you must use captions, follow these guidelines:

■ Begin with a capital letter.

■ Use sentence case.

■ Be brief but explain the usefulness of the figure or table.

■ Use ending periods only is the caption is comprised of multiple sentences.

■ Avoid repeating content that is already stated in a preceding paragraph or in the
topic title.
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At the discretion of the writer, if a caption is needed for just one table or figure in a
publication, captions can be applied throughout the publication, but this is not a
requirement.

Example

Captions add to the visual clutter (excessive information) on a page, which can slow
comprehension and reduce the usability of a document. Notice in the following example
that the "after" version is easier to scan and understand when the visual clutter is
eliminated (unnecessary heading, paragraph, and caption).

Before After
The phrase “Supported Languages and Interpreters” is
repeated in two headings, in the introductory paragraph,
and in the caption.

A succinct introductory paragraph improves readability,
reduces visual clutter, and reduces cognitive load.

Note: The <figure> element provides a function that allows users to click on images
to enlarge them in the online Help. For images that need to be enlarged, it is
acceptable to delete the <title> element (after the <figure> element) to remove the
caption while still allowing users to enlarge the image.

Cross-References
Cross-references link to information that adds to a reader's understanding when that
information is too extensive to duplicate.

Tip: The term cross-reference does not apply to table and figure captions. Instead,
see Captions (Titles) for Figures and Tables.

Guidelines for cross-references:

■ Use as few cross-references as possible to avoid link fatigue (the constant
interruption of the reading flow, which reduces comprehension and increases
cognitive load).

■ Link only to the most important content. If content is tangential or simply
informational, omit the cross-reference.

■ Avoid adding the same cross-reference multiple times in a single topic.
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■ Instead of using a cross-reference for brief content, consider turning it into a
<conref> or duplicate the content.

■ Excessive cross-references can be a sign that content is poorly organized.
Whenever possible, provide information in context rather than sending readers to
other parts of a publication.

■ To avoid topics that contain too many cross-references, prioritize the list of "linked-
to" topics, then link only to the top priority topic. From that topic, link to the next
topic in priority order, and so on.

"See Also" cross-references are reserved for legacy documents, indexes, and
glossaries. For guidelines about using the See Also icon, see Notes.

Word Usage
Use the following verbiage for cross-references:

■ Use see instead of refer.

- Use: For more information, see Scorecard Constraints.

- Avoid: For more information, refer to Scorecard Constraints.

■ Use about instead of on.

- Use: For information about indexes, see Managing Indexes.

- Avoid: For information on indexes, see Managing Indexes.

■ Use text to introduce a link if the link is not self-explanatory.

- Use: For information about how to get started, see Build your first app.

- Avoid: See the related topic.

- Avoid: Click here.

■ If introductory text is used (it is not required), avoid repeating the link text.

- Use: For information about authentication and authorization, see Using OAuth 2.0.

- Use: See Using OAuth 2.0 for Authentication and Authorization.

- Avoid: For information about using OAuth 2.0 for authentication and authorization,
see Using OAuth 2.0 for Authentication and Authorization.

■ If a file is downloaded when a link is clicked, clearly explain the result and the file
type.

- Use: For instructions, download the security features PDF.

Links to Shared Topics
PDFs can contain links between topics in the same publication (or to external websites)
but not to topics that are shared or reused in other publications. For online Help, links to
shared topics can work if the link in the online Help points to a document in the same
location.
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Use the following format for cross-references to other publications:

■ Use: See "Setup" in the TRIAD User Guide.

Avoid Overuse
Cross-references are the most effective when used sparingly and only when essential.
Users are often reluctant to click links for fear of losing their place or of being directed
away from their main concern. In a recent usability study, one technical writing team
discovered that their cross-references were clicked at most only 8% of the time. See
How SalesForce Let Go of Inline Linking on YouTube.

Page Numbers in Cross-References
Page numbers are only needed for certain FICO legacy products. For newer products,
avoid using page numbers for cross-references in both online and PDF output.

For instructions about suppressing page numbers, see "Altering Page Number Settings"
in the DITA Authoring Guide.

Reltables and Conrefs
Relationship tables (reltables) and content references (conrefs) are useful alternatives
to cross-references. It is acceptable to use a combination of cross-references (for
contextual information) and reltables in a single topic. For an overview, see "Reusing
Content" in the DITA Authoring Guide.

■ Reltables append a list of links to the end of a topic. Use reltables instead of cross-
references in topics that are shared with (reused by) another publication. The links
in reltables will point to other topics only if those topics exist in the other publication.
For instructions, see "Relationship Tables" in the DITA Authoring Guide.

■ Conrefs are reusable chunks of frequently used content (such as notes, definitions,
and tables) that are stored in conref target libraries. For instructions, see "Inserting
a Conref in a Topic" in the DITA Authoring Guide.

Dates and Time
Expressing dates and times in a clear and unambiguous way helps support writing for a
global audience and reduces confusion.

Time
Use the following guidelines to express time:

■ Use the 12-hour clock unless a 24-hour clock is required. If the UI, a command, or a
code sample uses the 24-hour format, use that format throughout for consistency.

■ Try to avoid referring to time zones. If required, treat the names of time zones as
proper nouns in uppercase letters: Central Time, Eastern Time, and Pacific Time.

■ Use exact times when possible, but noon and midnight are acceptable.

■ For ranges of time, use an en dash without spaces.
Use: Wait for 5–10 minutes.
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■ Capitalize AM and PM, without punctuation, preceded by one space.
Use: 3:45 PM

■ Remove the colon and zeros from round hours.
Use: 3 PM

■ Avoid references to standard time or daylight time.

Dates
Use the U.S. convention of writing the month first. Spell out the names of months and
days of the week in the format Month DD, YYYY, using the full four-digit year.

Use: December 23, 2026

Avoid: 23 December 2026

Avoid: 12.23.2026

Avoid: 12/23/2026

If including the day of the week, add it before the month as follows: Day of the Week,
Month DD, YYYY.

Use: Tuesday, April 27, 2026

Numeric Date Format
If you must express a date in numerical date format, use the format YYYY-MM-DD,
separated by hyphens, which conforms to ISO 8601 international standards for
numerical date format.

Examples
Introduce examples in a sentence using the following guidelines:

■ In the middle of a sentence, use parentheses if the example is short. Otherwise,
rewrite the sentence.
Use: Enter a six-digit hex number (for example, 228B22), then click OK.
Avoid: Enter a six-digit hex number (for example, if you want the color forest green,
enter 228B22), then click OK.

■ Add the example as a new sentence if the example is lengthy and can be framed as
a complete sentence.
Use: Enter a six-digit hex number, then click OK. For example, if you want the color
forest green, enter 228B22.
Avoid: Enter a six-digit hex number, then click OK. For example, 228B22.
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■ Separate the example using a preceding comma (but no following comma) if the
example must be added at the end of a sentence. Avoid any punctuation other than
a comma.
Use: Enter a name for the instance, for example my-instance-99.
Avoid:

- Enter a name for the instance, for example, my-instance-99.

- Enter a name for the instance: for example, my-instance-99.

■ In case the example is a code snippet, format it in a separate line.
Use: Ensure to add the required metadata and its value to your master map. For
example:
<othermeta content="XYZ" name="ABC" />
Avoid: Ensure to add the required metadata and its value to your master map. For
example, <othermeta content="XYZ" name="ABC" />.

Footnotes
A footnote is an annotation with additional information usually provided at the end of a
page, chapter, or book. Avoid footnotes because they are not accessible and can
present challenges for localization efforts.

Graphics
Use graphics only when they help complete a task or understand a concept. The term
graphic applies to all forms of non-text illustrations, including images, icons, flowcharts,
and screenshots.

Alt Text
Add alternative text (alt text) to all screenshots, flowcharts, and diagrams. Alt text
provides a written description for users who rely on screen readers, text-only browsers,
or low bandwidth internet.

Do not duplicate anything already explained in the body text. Use full sentences with
proper punctuation. Do not use figure captions to replace alt text. For more information,
see "Adding Alt Text to an Image" in the DITA Authoring Guide.

Use: The Customer Profile page shows the name, demographics, bio, and job title of the
customer, including the products they use. The emphasis is on the "Activity" tab, where
metrics shows key details about the customer's support tickets.

Avoid: The Customer Profile page

Screenshots
■ Capture only the part of the user interface that is relevant to a task. Try to avoid full-

screen captures.

■ Remove or blur personally identifying information (PII), version numbers, product
names, logos, and company details.
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■ Remove or blur real user names and data, or replace them with placeholders, such
as John Doe, 12345, or username@email.com.

■ Try to avoid figure captions (titles). If you add a caption, use sentence case.

■ To apply a border to an image, see "Adding a Border to an Image" in the DITA
Authoring Guide.

Icons
■ Inline images for icons are acceptable.

■ If a user interface is less than intuitive or if it uses a large number of icons, use a
table to discuss the icons, grouped by function or role.

■ For icons that are referenced in multiple places in a publication, consider placing
the icon tables in an appendix.

For more information, see User Interfaces.

Diagrams and Charts
■ Use diagrams and charts to show workflows, relationships, data, and structures.

■ Apply Lucidchart visual standards. See Lucidchart visual standards.

Callouts
■ Numbered callouts in images are acceptable but not required. If you use numbered

callouts, define them in a table below the image.

■ Avoid embedding text directly inside graphics.

Italicized Words
Use italics (not bold text or quotation marks) to draw attention to a particular word or
phrase, such as introducing a key concept, defining a new word, or emphasizing a
specific word.

Use: A scorecard is a generalized additive model of binned predictors.

Avoid: A scorecard is a generalized additive model of binned predictors.

Use: Do not use & (ampersand) as a conjunction. Use the word and instead.

Avoid: Do not use "&" (ampersand) as a conjunction. Use the word "and" instead.

Keystrokes
Keyboard shortcuts allow users to quickly accomplish tasks they perform frequently.

It is generally not necessary to describe all possible methods used to accomplish a task,
for example, select File > Open, or press Ctrl + O, or click Open.

Overusage of keyboard shortcut callouts could result in confusion and may disrupt the
flow of the document. If writers must provide keyboard shortcuts, do not place them in

Chapter 5: Format and Structure

Fair Isaac Corporation Confidential and Proprietary Information 48

mailto:example@email.com
https://lucid.app/lucidchart/43377264-%20b2db-4ed4-9697-76ebce2fff80/edit?invitationId=inv_23b269e3-4678-4b0f-928c-%20%20d041b352a571


procedures. Instead, refer advanced users to a table in a separate reference topic listing
the shortcuts elsewhere in the guide. If the number of keyboard shortcuts is large,
separate the shortcuts by function into multiple tables to avoid large tables in the
documentation.

To document shortcut keys, use the plus sign (+) for keys that are pressed
simultaneously and the comma (,) when a key is released. Apply the <uicontrol>
element to all keyboard keys that users can press, including Ctrl, Shift, Enter, and
Delete.

EXAMPLES

■ To describe holding down all keys at once, use the following format:
Alt + O: Press and hold down Alt and then press O.
Ctrl + Shift + B: Press and hold down Ctrl and Shift and then press B.

■ To describe pressing and releasing keys in succession, use the following format:
Alt, F, D: Press and release Alt, press and release F, and then press and release D.
Esc, M, P: Press and release Esc, press and release M, and then press and release
P.

■ To describe a combination of holding down and pressing or releasing keys, use the
following format:
Esc, Shift + T, R: Press and release Esc, press and hold down Shift while pressing
T, release all keys, and then press and release R.

Lists
Use lists to present complex text in a format that is easier to scan than if the same
content were to be embedded in a paragraph, separated by commas.

Numbered Lists
Use ordered (numbered or lettered) lists for information that requires a specific order or
sequence, such as a procedure or prioritized items.

Example

To sign in to the database:

1 Click File > Open Database.

2 In Username, enter your name.

3 In Password, enter your password, then click OK.

Bulleted Lists
Use unordered (bulleted) lists for related items that do not need to appear in a particular
order.

Example
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The database owner can:

■ Create and delete a database.

■ Add, delete, or modify a document.

■ Add, delete, or modify any information in the database.

Introductory Text
Clearly state the purpose of each list with a sentence or fragment that ends with a
colon. If content is localized, avoid fragments.

Use these same guidelines for lists in table cells.

It is acceptable, but rare (usually only in API docs), to introduce a list without
introductory text. In this case, use the heading to introduce the list. Do not use a colon
or period at the end of the heading.

If you use the word “following” try to use it as an adjective rather than a noun. For
example, instead of “Do the following” use “Do the following actions.” Also avoid
sentences that begin “The following are…”.

It is acceptable, but rare (usually only in API docs), to introduce a list without
introductory text. In this case, use the heading to introduce the list. Do not use a colon
or period at the end of the heading.

Capitalization
Begin each list item with a capital letter unless the items require lowercase, such as a
list of commands.
If lowercase is required for any of the items in a list, ensure that all items are lowercase
or rewrite the list to begin each item with a capital letter.

Punctuation
Use a period at the end of list items only if they are complete sentences.

If a list contains both fragments and sentences, end all of the list items with periods.

Avoid using semicolons, commas, or conjunctions (and, or) at the end of list items.
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All punctuation guidelines also apply to content in tables.

Structure
Avoid lists with a single list item. Step lists with a single step are allowed, but use them
rarely and only for tasks (not for other types of lists).

Use the same syntax and structure (for example, all noun phrases or all verb phrases)
for the items in a list, whenever possible. Try to avoid starting list items with the infinite
form of verbs (“To do x…”).

Examples
Recommended Not Recommended Reason

The editor toolbar provides the
following commands:

■ Check in the decision logic.

■ Compile the decision logic.

■ Run options to detect
anomalies.

The editor toolbar provides the
following commands:

■ Check in the decision logic.

■ The ability to compile the
decision logic.

■ Options to detect anomalies.

Make lists parallel, either all
verb phrases or all noun
phrases.

Click Submit to do the following
actions:

■ Submit the form.

■ Indicate that you are done.

■ Allow the next person to enter
data.

Click Submit to do the
following:

■ To submit the form.

■ To indicate that you're done.

■ To allow the next person to
enter data.

Use “following” as an adjective
rather than a noun. Avoid
creating list items of infinitives.

To download the USB driver:

■ Click Tools > Android > SDK
Manager.

■ Select Google USB Driver,
then click OK.

To download the USB driver,
perform the following steps:

■ Click Tools > Android > SDK
Manager.

■ Select Google USB Driver,
then click OK.

Be brief.

Objectives

■ Create an instance

■ Snapshot an instance

■ Delete an instance

Objectives
In the following tutorial, you will
complete the following tasks:

■ Create an instance

■ Snapshot an instance

■ Delete an instance

Introductory text can be
omitted if the heading
adequately introduces the list
and the subject is clear.
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Recommended Not Recommended Reason

The colors of the rainbow
appear in the following order:

■ 1 Red

■ 2 Orange

■ 3 Yellow

■ 4 Green

■ 5 Blue

The following are the colors of
the rainbow in order of
appearance from top to bottom:

■ 1 Red

■ 2 Orange

■ 3 Yellow

■ 4 Green

■ 5 Blue

Use “following” as an adjective
rather than a noun.

The advantages of using Tech
Company:

■ Enhanced processing

■ Ease of use

■ Adaptability

There are three advantages to
Tech Company:

■ You can work quickly.

■ Ease of use

■ Often adaptable

Make list items parallel. Use
consistent ending punctuation.
Avoid false subjects (sentences
that start with “There is,” “There
are,” or “It is.”)

The database owner can:

■ Look high

■ Look low

■ Look everywhere for data

The database owner can:

■ look high,

■ look low, or

■ look everywhere for data.

Avoid ending with commas
and conjunctions. Start each
list item with a capital letter.

Notes
Notes provide supplementary information that enhances understanding without
interrupting the content flow.

Notes can clarify concepts, offer cautions, or add insights that are helpful but not critical
to the main instruction. The proper use of notes ensures that the reader remains
focused on key information while gaining useful details.

The following types of notes are supported:

■ Note

■ Tip

■ Important

■ Caution

■ See Also

Notes must be brief to avoid interrupting the flow of information.

Do not repeat the note label in the text of a note.

■ Avoid:

Tip: This tip...

When several notes appear consecutively, use the following standards.
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Description Example

For multiple notes of the same type, consider
using an introductory sentence followed by a
bulleted list. Stacked notes (multiple DITA <note>
elements) are also acceptable.

Note: When working with user-defined pages,
consider the following parameters:

■ User-defined text fields support 999,999
characters, and they display 80 characters per
line.

■ When merging two consumers, the UDPs on
the merged consumer account are moved to
the target (new) consumer. Additionally, the
consumer UDPs will be moved to the target
consumer, depending on how your system was
configured during implementation.

For multiple notes of different types, keep the
notes separate.

Note: When working with user-defined pages,
consider the following parameters, user-defined
text fields support 999,999 characters, and they
display 80 characters per line.

Caution: If you enter 1 million characters or
more into a user-defined text field, your computer
may overheat.

Note
Use standard notes to offer additional information or context that clarifies the main
content. You might use a note to explain why a particular setting is recommended or to
provide background on a technical concept.

Use:

Note: This setting is best suited for high-traffic environments.

Tip
Use tips to provide optional but helpful advice.

Use:

Tip: To connect elements, hover over an element until the hand icon appears.

Important
Use important notes to provide pivotal to the information or to help users retain crucial
information.

Use:

Important: Do not use spaces in element names.

Caution
Use cautions to alert users to proceed carefully because of potentially serious
consequences, such as the loss of data.
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Use:

Caution: If you delete an existing template, you cannot recover the template data.

See Also
Use "see also" notes to reference related but non-essential information in an external
FICO document that might add to a reader’s understanding. "See also" notes are used
only in legacy publications; avoid using them in newer ones. Do not use "see also"
notes to refer to a topic in the same publication.

"See also" notes are allowed in index and glossary entries. For guidelines, see
Glossaries.

Guidelines for "see also" notes:

■ Use the "see also" icon sparingly and only for external references.

■ Avoid using "see also" citations without the icon, except in glossaries and indexes.

■ When using the "see also" icon, explain the redirect (For information about...).
Include the name of the specific topic in the other guide whenever possible.

■ For additional guidelines, see Cross-References.

Use:

See Also: "Paragraph and Character Markup" in the DITA Authoring Guide.

See Also: For information about creating "see also" references, see "Cross-
References and Related Information" in the DITA Authoring Guide.

Numbers
When you write about numbers that are used in examples or a UI, present them exactly
as they appear in the UI. In all other content, use the following guidelines.

Numerals or Words
Use numerals for 10 and greater. Use words for numerals less than 10.

■ Use: The product consists of 14 modules.

■ Use: The application uses five databases.
It is acceptable to use numerals less than 10 when space is limited, such as in
tables.

Use numerals 0-9 for items of the same type if they occur in the same sentence with
numbers 10 and greater.

■ Use: The settings page contains 15 options but 6 are disabled by default.

■ Avoid: The settings page contains 15 options but six are disabled by default.
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When two numbers that refer to different things must appear together, use a numeral for
one and spell out the other.

■ Use: The website contains fifteen 20-page articles.

■ Use: The platform allows up to ten 100 MB files.

Use words for numbers that start a sentence.

■ Use: Ten records were updated.

For numbers that have four or more digits, use commas.

■ Use: 1,093 MB

■ Avoid: 1093 MB

For numbers typed into the UI, use numerals even if less than 10.

■ Use: In No. of Rows, type 5.

Spell out ordinals. Do not use ordinals for dates.

■ Use: First, fifty-fifth, thirty-second

■ Avoid: 1st, 55th, 32nd

■ Use: June 1, 2025

■ Avoid: June 1st, 2025

Exception: Numerals (1st, 55th, 32nd) are acceptable if space is an issue.

Units of Measure
Use numerals for the following types of information.

Usage Examples

For measurements of distance, digital storage,
volume, size, weight, pixels, and points, use
numerals even if less than 10.
Express abbreviations without periods.
Add a space before the unit of measure.

■ 3 feet, 5 inches

■ 50 MB

■ 1.76 lb

■ 80 × 80 pixels

■ 0.75 grams

■ 3 centimeters

■ 0.5 cm

For dimensions, such as tile sizes, screen
resolutions, and paper sizes, use the
multiplication sign (×).
Use a space before and after the multiplication
sign.

■ 4 × 4 tile

■ 8.5" × 11" paper

■ 1280 × 1024

For percentages, use a numeral plus the percent
sign (%) without a space.

50%
Exception: To begin a sentence, spell out the
numeral, followed by the word percent.

Express fractions as numbers whenever
possible.

0.75 or 3/4

Chapter 5: Format and Structure

Fair Isaac Corporation Confidential and Proprietary Information 55



Usage Examples

Exception: If words are required, connect the
numerator and denominator with a hyphen (three-
fourths).

For negative numbers, use a hyphen before the
numeral without a space, even if the number is
less than 10.

-5

For round numbers of 1 million or more, use
numerals even if less than 10.

7 million

For ranges, use from and to or through. ■ from 100 GB to 200 GB

■ pages 5 through 15
Exception: Use an en dash without spaces if
space is an issue (2016–2024).

For money, use numerals for exact or
approximate amounts.
Assume U.S. dollars unless otherwise noted.
For guidance about foreign currency, consult an
authoritative site, such as xe.com.

■ $28.95 per unit

■ cost of $60,000
Exception: Use words for indefinite amounts
(several thousand dollars).
For rounded amounts over one million dollars,
use numerals and words ($6.3 million)

Paragraphs
Use paragraphs to create logical units of thought, to break up content, and to signal the
beginning of a new topic.

A topic sentence states a paragraph's main idea, while the rest of the paragraph
supports and develops the topic with additional details. Start a new paragraph whenever
the subject significantly changes.

A paragraph should be just long enough to adequately deal with the subject of the topic
sentence. A series of overly short, underdeveloped paragraphs can sacrifice unity by
breaking a single idea into confusing pieces, while a series of long paragraphs can
overwhelm readers. Either extreme can hamper reading comprehension. Careful
paragraphing helps readers understand the logic and flow of information.

Sentences
The goal is to write sentences that are clear, concise, correct, and complete.

■ Keep sentences short. Consider limiting sentences to 15-20 words.

■ Put critical information first. Readers tend to scan. They read a full sentence only if
the first part is pertinent to their goal.
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■ Choose strong, specific verbs. Try to avoid weak verbs, such as forms of be (is, are,
am, was, were, etc.), occur, happen, manage, and others.
Use: Dividing by zero raises the exception
Avoid: The exception occurs when dividing by zero.
Use: The system generates this error message when...
Avoid: We are very careful to ensure...

■ Use transitional verbiage to link sentences and signal the relationships between
them:

- Cause and effect: therefore, as a result, consequently, because.

- Contrast: however, on the other hand, although, yet

- Addition: furthermore, in addition, also, moreover

- Sequence: first, next, then, finally
Use: The system failed to initialize. As a result, the startup sequence was aborted.
Avoid: The system failed to initialize. The startup sequence was aborted.
Use: While the dashboard provides an overview of your recent activity, the reports
section offers more detailed analytics for deeper insights.
Avoid: The dashboard displays your recent activity. The reports section shows
detailed analytics.

Writing for Clarity
Carefully constructed sentences provide clarity, which allows readers to comprehend
quickly without having to reread.

■ Verbs. Try to avoid burying verbs at the end of sentences.
Use: A central identity gateway orchestrates a series of interconnected
microservices that manage user authentication across distributed environments.
Avoid: The series of interconnected microservices, each responsible for handling
discrete aspects of user authentication, is orchestrated by a central identity
gateway.

■ Modifiers. Avoid dangling modifiers (often introductory phrases) that fail to clearly
refer to the correct noun or pronoun.
Use: While I was eating lunch, my computer crashed.
Avoid: While eating lunch, my computer crashed. (Who was eating lunch?)

■ Assumed subjects. Explicitly state the subject instead of assuming that the subject
is clear.
Use: The program sends a request to the host program to end the session after the
last command.
Avoid: The program sends a request to end the session after the last command. (To
whom or what is the request made?)

■ False subjects. Reduce false subjects, which replace the real subject of a sentence
with there are, there is, or it is.
Use: The data can be formatted in multiple ways.
Avoid: There are multiple ways to format the data. (The true subject is data.)
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■ Nouns. Deconstruct strings of three or more nouns that are used as a single
thought (noun stacks). Noun stacks confuse and slow down readers, leading to
misinterpretation.
Use: The user is blocked if they exceed the attempt limit when answering the
password security question.
Avoid: The user is blocked if the failed password security question answer attempts
limit is exceeded. (What has been exceeded?)

■ Noun Structures. Reduce nominalizations, which are nouns created from verbs and
adjectives by adding -ion, -ment, -ance, and -ency. Nominalizations cause
wordiness, weaken sentences, and result in passive voice. Replace nominalization
with nouns in active voice.
Use: The flag indicates an error state.
Avoid: The flag is an indication of an error state.
Use: The algorithm creates fine bins first, then the coarse bins.
Avoid: The algorithm performs the creation of the fine bins before the creation of
the coarse bins.

■ Pronouns. Avoid vague and ambiguous pronouns (it, them, they) that are unclear
about which noun, clause, or phrase is referred to by the pronoun. Rewrite to
eliminate the pronoun or place the pronoun as close as possible to its antecedent
(the thing it refers to).
Use: In notebooks, active interpreters appear as blue rectangles.
Avoid: Notebooks that contain interpreters are represented as blue rectangles when
they are active. (What is active, the notebooks, the interpreters, or the rectangles?)

■ Adjectives and Adverbs. Use adjectives (like strong, quick, better) and adverbs
(like really, actually, very) carefully. Because they tend to be loosely defined and
subjective, they are more appropriate for marketing material than technical writing.
Use: You can convert your input test data into JSON data.
Avoid: You can easily convert your input test data into JSON data.
Use: By setting this flag, you can improve performance up to 200%.
Avoid: By setting this flag, you can expect much better performance.

■ Conjunctions. Reduce the use of word pairs joined by conjunctions (and, or).
Paired words (such as terms and conditions or design and development) are often
synonyms or near-synonyms. Use only the more precise of the two terms or find a
broader term that can replace the pair.
Use: Replace the links.
Avoid: Remove and replace the links.
Use: Use the dashboard to administer system performance.
Avoid: Use the dashboard to monitor and control system performance.

Procedures
A procedure is a sequence of numbered steps that accomplish a task.

The best practice for procedures is to provide only information needed to complete a
specific goal. When multiple methods exist, present only the best approach. Use the
fewest possible steps to minimize interruptions and confusion.
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Task Titles
Task titles must clearly identify the goal of a procedure so users can quickly find the
information they need.

■ Use imperative (command) voice and verbs in base form (without endings like -ing,
or -ed) to explain the goal of the task, such as Create a Log Report or Configure
Model Parameters.

■ Use singular nouns when referring to a single action or object, such as Generate a
Report. Use plural nouns only when a task involves multiple items, for example:

- Compare Results

- Review All Segments

- Run Multiple Tests

■ Avoid using gerunds (verbs that act like nouns by adding -ing).

■ Be concise. Try to avoid titles that exceed 4–5 words.

■ Try to avoid vague verbs like manage, handle, do, make, and have. Instead, choose
strong verbs that accurately reflect the specific action being performed.

For more information, see Titles.

Introductory Sentences
In most cases, introduce a procedure with a sentence or two that describe the context of
the task, including requirements and prerequisites.

■ Avoid introductory sentences that are self-referential, such as Use this procedure to
do xxx. Instead, add value by explaining the purpose, context, or outcome. For
example:
Confirm Models in FICO Platform Catalog
Status appears in the FICO Platform Catalog. Before you incorporate a Python ML
or PMML model in a FICO Platform solution, verify that the model is in the FICO
Platform Catalog.

u Get the model deployment name based on model type:

- For a Python model…

- For a PMML model…

■ Do not repeat the task title. If the title adequately explains the task, it is acceptable
to omit the introduction.

■ Avoid superfluous text for the sake of populating a DITA element.

■ Do not include prerequisites that are obvious, such as Before you assign a work
queue, create at least one queue and one user.

For additional guidance, see Short Descriptions on page 63 and Lists.
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Format
■ Consider breaking long procedures into multiple shorter tasks. Consolidating and

simplifying related steps can help shorten overly long procedures.

■ Limit the use of cross-references to those that are essential to completing the task.
Avoid adding cross-references that are merely informational. See Cross-
References.

■ Limit the use of graphics in procedures but use them where needed. Inline icons are
acceptable, especially when icons lack labels in the UI. For guidelines, see
Graphics.

Steps
■ Use the imperative voice for steps that directly address users and tell them to

perform an action.

■ Ensure that each numbered step contains an action statement. Do not format
explanations and results as numbered steps.
Use: 1. In the Navigator pane, click Explore.
Avoid: 1. In the Navigator pane, you can explore the data.
Avoid: 1. You can explore the data in the Navigator pane.

■ To help users understand where to complete an action, provide the location of the
action before stating the action.
Use: In the Admin pane, click Manage Users.
Avoid: Click Manage Users in the Admin pane.

■ State the goal of the action before stating the action.
Use: To start a new document, click File > New > Document.
Avoid: Click File > New > Document to start a new document.

■ It is acceptable to combine closely related steps, especially when the final step is to
click an OK, Save, or Apply button.
Use: 1. Select the Export option, then click OK.

■ Avoid directional language, such as above, below, or right-hand side, because it
causes issues for accessibility and localization. If a UI element is difficult to find,
provide a screenshot.
Use: In the table below...
Avoid: In the following table...
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Symbols
■ It is acceptable to use angle brackets to shorten a sequence of related actions. Add

a space before and after each bracket. (The DITA <menucascade> element
automatically inserts brackets.)
Use: Click View > Tools > Developer Tools.

■ Avoid including keyboard commands if words are sufficient.
Use: Copy and paste the object.
Avoid: Press Ctrl+C, and then press Ctrl+V to paste the object.

■ To refer to icons, use the name of the icon (often in a tooltip) followed by the
symbol in parentheses.

- Without a tooltip, use Click the plus sign (+) or Click the plus (+) icon.

- If named, always use the name, as in Click the Add (+) icon.

Results
■ State the results of a step only when it is important to assure users that they are on

the right track or when the information is necessary to move users to the next step.
Use:
1. Click Run. After the query finishes, the results are displayed. (You can optionally
format the result statement in a new line.)
Use:
1. Click Constraints to open the Add Cross-Constraints dialog.
Use:

1 Click Enter.

2 In the New File dialog, click Next.

Avoid:

1 Click Enter. The New File dialog opens.

2 In the New File dialog, click Next.

■ When helpful, follow a procedure with an explanation of the expected results,
examples that illustrate the task, or actions that must be performed after the task.

■ If a step ends with code sample, it is acceptable to omit the end period if doing so
might confuse users who copy and paste code samples.

■ If a step ends with a URL, include the end period unless doing so might confuse
users.
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Sub-Steps and Options
■ Label sub-steps with lowercase letters. Use lowercase Roman numerals for sub-

sub-steps. Introduce sub-steps with an introductory sentence followed by a colon.
Use:

1 To add a VM instance, do the following:

a Click Create instance.

b For Name, enter a name for the VM instance, then do the following:

i For Region, specify where you want to deploy the VM instance.

ii For Machine type, select an option.

c Click Create.

2 To connect to the VM instance with your secure Shell, click SSH.

■ If a step has options, introduce the options with a phrase followed by a colon.
Format the options as a bulleted list.
Use:

u To train the scorecard, do one of the following actions:

- Click an editable scorecard version in the Versions pane.

- Click the Run ellipsis (…), then select New Version.

■ Avoid repeating or summarizing sub-steps in the introductory sentence.
Use:

1 To create a new project, do the following:

a Open the Projects dashboard, then click New Project.

b Enter a name and description for the project.

c Select a template, then click Create.

2 Click Configure.

Avoid:

1 Create a new project by using a template that is opened by clicking the new
project button from the dashboard:

a Open the Projects dashboard, then click New Project.

b Enter a name and description for the project.

c Select a template, then click Create.

2 Click Configure.

Single-Step Procedures
When a single-step procedure occurs in a task topic, an arrow icon is inserted in place
of a bullet. Do not use single bullets in other type of topic. (Pretend that the following
bullets are arrow icons. They appear as bullets here because they are not used in a
<steps> element.)
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Use:

■ To clear (flush) the entire log, click Clear logcat.

Avoid:

To clear (flush) the entire log, do the following:

■ Click Clear logcat.

Short Descriptions
Use the <abstract> element for the initial paragraph of every topic. In the
<abstract> element, assign the <shortdesc> element to the sentence (or two) that
summarizes the topic.

Short descriptions appear in the following places:

■ In the search results of the online Help

■ In the flyover description in the table of contents in the online Help

■ At the end of top-level online Help topics in a "Covered Topics" list

■ At the end of topics in “Related Topics” lists in both PDF and online Help

Note: The content that you tag as a <shortdesc> is not longer formatted as a
paragraph that is separate from the <abstract>, so the <abstract> element is now
identical in our PDF and Help output.

Guidelines
Write short descriptions using the following guidelines:

■ State the purpose of the topic without repeating the topic title.

■ Use complete sentences. However, incomplete sentences are acceptable for API
topics.

■ Avoid ending with a colon.

■ Avoid URLs, figures, tables, and links.

■ Avoid introducing any kind of list.

■ Be brief.

■ Avoid “above” and “below.”

■ The abstract can be as long as needed to introduce the topic, but limit short
descriptions to 35 words in 1-2 sentences.

Content
Avoid writing abstracts and short descriptions that are self-referential. For example, do
not write “This topic describes…”, “The procedure in this section shows…”, “Use this
topic to…” or “Follow these steps to…”
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Style
Because short descriptions are presented in Related Topics and Covered Topics lists,
try to make each description unique. Also, try to write them in a similar style and
construction so they are parallel with all other short descriptions in a publication.

Short Descriptions by Type
■ Task topics:

- Describe the user goal.

- State the benefits.

- Explain why and when the task is performed.

- Focus on the user goal and not on the UI function.

■ Concept topics:

- Introduce the subject.

- Explain why the user should read the topic.

■ Reference topics:

- Describe the nature of the reference information.

- Describe why and when to use the information.

Examples
The following examples explain how to follow the best practices for short descriptions.

Recommended Not Recommended Issue

Analysts can use the View Case
option to review cases and act
based on information in the
Case Manager.

Analysts can use this topic to
understand how to use the View
Case option to review cases and
act based on information in the
Case Manager.

Avoid self-referential language.

You can select from a list of
cases in a specified queue if you
have permission to work cases
in Manual mode.

With permission to work cases
in Manual mode, you can select
from a list of cases in a specified
queue.

Rewrite short descriptions to be
parallel with other short
descriptions in the publication. In
this case, assume that most
other short descriptions start
with “You can do x…”
statements.

Scorecard training uses
machine learning algorithms that
allow you to visualize and
analyze predictive insights and
modify binning.

Train a scorecard to discover
predictive insights by using
FICO's built-in machine learning
algorithms. You can visualize,
analyze, and modify the fine and
coarse bin statistics. Model
quality metrics and graphs for
training and assessment data
are available. You can also
specify the fit settings, fit the log-
odds-to-score relationship, and

Tag a single sentence as the
short description instead of an
entire paragraph. Write short
descriptions to effectively
summary a topic.
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Recommended Not Recommended Issue

generate scaled weights for the
scorecard version. In addition,
you can view logs about the
scorecard version training and
variable selection.

Before you configure your own
models and services, familiarize
yourself with Decision
Management Suite by building a
sample solution.

The following steps to create a
simple decision model and
deploy it as a decision service:

Avoid using an introduction to a
list as a short description.
Provide a succinct summary of a
topic.

Create Segmented Scorecards
Segmented scorecards use a
trained, scaled scorecard and a
decision tree to separate a total
population into subpopulations.

Create Segmented Scorecards
You can create segmented
scorecards.

You can create segmented
scorecards.

Tables
Tables are useful when you need to simplify and clarify complex data, save space, show
relationships, emphasize key points, and reduce redundancy. Use tables judiciously and
only when they add value and clarity.

Placement
■ Place tables immediately after the discussions they support. If a table is overly

large or if it will be referred to from multiple places in a user guide, place the table
in a separate reference topic and consider placing it in the appendix.

■ Do not insert tables in the middle of a sentence. Avoid placing tables in the middle
of sentences or paragraphs.

■ Introduce all tables. Always introduce a table in the paragraph that immediately
precedes it. In the introduction, explain the main point of the table. Use terms like
previous, preceding, following, and next to refer to the table rather than
above or below.

Formatting
■ Complex tables. Keep tables simple and avoid nested tables.

■ Table titles. Table titles (captions) are optional. See Captions for Tables and
Figures.

■ Colons in introductory text. Do not use colons at the end of the sentences that
introduce tables.

■ Punctuation marks in column headings. Do not end the column headings with
punctuation marks such as periods, ellipses, or colons.

■ Effective column headings. Keep column headings short and clear. Use title case
and omit articles unless necessary. Insert a break between the words in the
heading to keep the column width appropriate.
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■ Logical arrangement of rows. Arrange rows in a logical order or alphabetically if no
logical order is required.

■ Consistent column construction. Use parallel construction for the content of each
column. For example, use all nouns or all verb phrases per column.

■ Single-row tables. Try to avoid tables with only one row unless doing so is required
for consistency in a reference document.

■ Single-column tables. If a table contains only one column, turn the table into a list.

■ Code snippets. It is acceptable to add code snippets in tables, but avoid creating
tables that contain only code snippets. In that case, list the code snippets in a list.

■ Sentence-like column headers. Do not construct column headers in a way that
creates a complete sentence when the headers are combined. This can make a
table difficult to localize.

■ Units of measure. If all data in the table is expressed in the same unit, specify that
unit in the table title. If all the data cells in a column use the same unit, specify that
unit in the column heading, rather than in each data cell.

■ Blank cells. Leave cells blank when the cell has no relevant data rather than using
an ellipsis or hyphen. However, if the cell should represent a zero, enter "0" instead
of leaving it blank.

■ Footnote with asterisks. Try to include explanations where they occur in a table cell
instead of using footnotes at the bottom of tables.

Titles
Titles are most effective when they are strong and concise. The goal of titles is to allow
readers to effortlessly scan through a table of contents to find what they are looking for.

Note: Technically, a title is the name given to a document, while headings divide a
document into logical sections; however, because our DITA structure uses “title”
elements for headings, this guide also uses the term “title” to refer to chapter and
topic headings.

Use the following guidelines to create chapter and topic titles:

■ Word Choice. Choose strong, concise words. Try to avoid using vague verbs that
can have multiple interpretations, such as make, handle, manage, and understand.

■ Capitalization. Use title case for titles. See Capitalization.

■ Hyphens. Capitalize the second part of hyphenated terms when the term is a proper
noun or when the second word would be capitalized as a standalone word in a title,
for example, Multi-Client Features.

■ Be Brief. Use as few words as possible (preferably fewer than four or five) and start
the title with the most impactful words.
Use: API Authentication
Avoid: Guidelines for Understanding API Authentication Methods

Tip: Usability studies report that readers tend to comprehend only the first 11
characters of a title, so shorter titles are much easier to scan and understand.
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For example, the TOC on the right is much easier to scan because the titles are
brief.

■ Best Practices

- Avoid two titles without content between them (known as stacked headings).

- Use plurals only if they are accurate.

■ Use: Set Up the Network

■ Avoid: Setting Up Networks

- Do not include other formatting in titles, such as bold or code style. If you must
mention a code item in a title, add a descriptive noun after the code item.

- Avoid titles structured as questions.

- Try to avoid punctuation in titles.

- If you use an abbreviation in a title, spell out the abbreviation in the first
paragraph.

- Do not use links in titles.

■ Information Architecture

- Nest topics sparingly and thoughtfully. Try to avoid more than four levels of titles.

- Use broader ideas for top-level headings and increasingly more specific headings
for each subsequent level. Think about a hierarchy of titles as a navigation system
that matches the mental model of users.
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Titles by Type
The wording in a title signals the nature of the content in a topic. Base your word
choices on information type.

Info Type Purpose Guidelines for Titles Before After

Chapter Top-level container
for all other topics

■ Use nouns and noun
phrases that
summarize the
subject of the
chapter.

■ Avoid verbs and
gerunds.

■ Prefer plural nouns
and noun phrases.

Reviewing and Managing
Cases

Case Reviews

Managing Advanced
Functions

Advanced Functions

Task Topics that answer
the question
How do I…?

■ Start titles with an
imperative verb

■ If a task is performed
in bulk, use a plural
noun: otherwise, use
a singular noun.

■ Avoid gerunds (verbs
that act like nouns by
adding
-ing).

■ Adjectives that end in
-ing are acceptable.

■ Use titles that reflect
a user goal instead of
a UI feature or
function.

Importing PMML Files Import a PMML File

Creating Parameters Create Parameters
Exception:
"Troubleshooting" is
acceptable as a title
because it is widely used
and understood.

Creating Versioning Log
Reports

Create a Versioning Log
Report
Versioning is an adjective,
not a gerund.

Using the Label Dataset
Wizard

Create a Dataset
This turned a feature-
based title into a task-
based title.

Creating, Importing, and
Downloading Data
Dictionaries

Convert Data to a Dataset
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Info Type Purpose Guidelines for Titles Before After

Concept Topics that answer
the questions What
is…? and Tell me
about…?

■ Use nouns and noun
phrases.

■ Avoid verbs.

■ Gerunds are allowed,
if unavoidable.

Collaborating on Projects Project Collaboration

Understanding Decision
Service Concepts

Decision Services

Data Modeling Data Modeling

Reference Topics that provide
quick access to lists
of facts, commands,
and specifications,
often referenced
from multiple other
topics

■ Use nouns and noun
phrases.

■ Avoid verbs and
gerunds.

Using Keyboard
Commands

Keyboard Commands

Handling Data Formats Data Formats

Run-in Headings
Run-in headings are bolded words that act as sub-headings at the beginning of list
items or a series of paragraphs. Especially in wordier lists and paragraphs, run-in
headings can improve scanability.

Run-in headings are optional, but they are useful for summarizing chunks of text. Apply
bold formatting to the first few words, followed by a period, colon, or en-dash
(surrounded by spaces). Avoid using em dashes, hyphens, or combinations of the
allowed punctuation. Avoid using bold for the punctuation.

Examples

Run-in headings can be followed by periods.

Run-in headings can be followed by en dashes (surrounded by spaces).

Run-in headings can be followed by colons.
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Chapter 6

User Interfaces

Elements in a user interface (UI) include the titles of windows, buttons, tabs, text boxes,
and more. UI elements are most often (but not exclusively) referred to in task topics to
help users accomplish specific tasks.

■ When documenting UIs, use the following rules for capitalization.

- Use title case for titles and short labels.

■ H1: Asset Management

■ Button Label: Add To

- Use sentence case for descriptive or action text.

■ Description: Use the tabs to toggle the tables

■ Action: Type a name…
For title and sentence case specifics, see Capitalization.

■ When documenting UI elements, match capitalization and spelling as closely as
possible without duplicating misspellings. Report or mitigate errors.

■ Do not include end punctuation with titles and labels unless omission might lead to
confusion.

■ Try to avoid including the widget type, such as menu, checkbox, or button. For
example, rather than write “Click the Save button,” write “Click Save.” It is
acceptable to include the element type if needed for clarity.

■ Do not use UI elements as verbs or nouns.

■ When referring to UI elements, use the uicontrol DITA element to apply
consistent formatting.

■ In general, write instructions for Windows users. If you want to add Mac
equivalents, place them in parentheses following the Windows element or action.
For example, “To copy, press Ctrl+C (Command-C for MacOS).”

■ For UI guidance for developers, see FICO UX Standards.

■ For accessibility and localization, avoid directionality language such as under or left.
See Accessibility.
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Main UI Elements
Use the following guidelines to refer to the main elements in a UI. Do not capitalize UI
element types, such as page or file, unless they appear capitalized in the UI.

UI Element Definition and Usage Example

Canvas An area for drawing or
manipulating graphical elements.

Click Start in the Tree canvas.
Click Start in the canvas. (If the canvas is not labeled.)

Console The physical terminal (keyboard
and monitor) used to interact with
a computer. For example, the
command-line interface (CLI) is
used within a console.

To view system logs, open the developer console and
select the Logs tab.

Dashboard A page that consolidates key
information into an at-a-glance
view.

In the Analytics dashboard, double-click the KPI that
you want to explore.

Dialog A modal or non-modal popup that
presents information or prompts
for a decision. Used for alerts,
confirmations, prompts, sign-ins,
and discrete actions.
It is acceptable to use dialog
rather than dialog box.

Click Save to open the Save To dialog.
In the Export dialog, select a file.

File, folder, directory A visual hierarchy for storing
various formats, such as
documents, images, videos, and
code.

Select the file and drag it into the folder. In the
Documents directory in Explorer, double-click a folder
to open it.

Left Nav See Pane in Dialog and Page
Elements.
North star*

Menu, menu bar A list of options, commands, or
actions, often presented in a
persistent toolbar at the top of a
page.
Use commands to refer to menu
items, if needed.
Do not use dropdown.

In the File menu, select Properties. To access Help,
click your profile icon in the menu bar.

Page The interactive section of a
window or website. Tabs often
display different pages. Wizards
usually have multiple pages.

The Performance page provides tracking metrics.

Screen The physical display area
(monitor) of a hardware device.
Not typically used in software user
guides.

Ensure that your primary screen is connected and
powered on.

Toolbar A quick access bar for frequently
used functions and navigation.

On the Processes toolbar, click Show Comment.
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UI Element Definition and Usage Example

Window A resizable, minimizable, closable
frame that contains the actionable
content of an application.

Click Finish to close the window.

Dialog and Page Elements
In general, avoid describing UI elements and how they function. Instead, focus on
describing the actions that users need to perform.

Avoid mentioning the widget type of a UI element as long as the element is clearly
labeled and its context is obvious based on the visual design. It is acceptable to include
the widget type if clarity is needed, such as when a UI element lacks a label, when a
page displays a similarly labeled UI element, or when navigation to an element is less
than intuitive.

UI Element Usage Example

Action Menu Action menus often use … or +
icons to open sub-menus. See
Icon in this table.

From the Action menu, select Export.
Click Action (+), then select Export.

Area Use the name of the area
whenever possible; otherwise,
describe the area as best you
can.

From Roles, change the roles assigned to the group.
In the area above the table, change the roles assigned
to the group.

Arrow, caret Use expand or click, and collapse
for verbs. Use arrow only if
needed.

Expand the Settings arrow for additional options.
Click Settings for additional options.

Button Refer to a button only by its label.
Do not use button.

Select a variable, then click OK.
To locate a file, click Browse.

Card An outlined group of related
actions or information, often
clickable. Refer to cards by name.
Do not use tile.

Click the Contact card to edit a phone number.

Checkbox Use select and clear for verbs. On the Explore pane, select All Workbooks. (The
checkbox is obvious.)
From Score Model Options, clear the
Show Grid Lines checkbox. (The page contains two
similarly named widgets.)

Combo box, list box,
spin box

Use list or box if needed for
clarity.
Do not use dropdown.

In Region, select an option. (The combo box is
obvious.)
In the Region list, select an option.

Dropdown list Dropdown lists appear anywhere
but in a menu bar.
Use list.
Do not use list box or dropdown.

In the Role list, select Target.
In Role, select Target.

Editor The part of a UI where users can
input and format text or code.

Click Decisions to open the Trees editor.
Return to the decision tree editor.
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UI Element Usage Example

If labeled, refer to an editor by
name.
If unlabeled, refer to the editor.

Field Use the label only whenever
possible.
Do not use box or text box.

For Username, enter your email.
Enter the special value you want into the field.

Icon If labeled, refer to an icon by its
label.
If unlabeled, refer to an icon with
an inline image.

Click the More (…) icon.
Click the ellipsis (…) icon to view the options.

Pane Use pane to discuss a separate,
persistent area of a window.
If labeled, refer to the label.
If unlabeled, refer to it as
navigation pane.

In the Comparison Results pane, click the Show
Visual Differences icon.
In the navigation pane, click InfoView.

Panel While panes are about layout,
panels are a group of functions or
UI elements specific to a page.
If labeled, refer to the label.
If unlabeled, refer to the location
as briefly as possible and ask for
a label.

In the Settings panel, adjust the score threshold.
In the upper-right panel, click Manage Users.

Pop-up, pop-over Do not use. See Tooltip. N/A

Radio button Do not refer to radio button.
Instead, refer to specific options
by name.
Use select as a verb. Use option,
if needed.

From Select the Calendar Type, select Gregorian
calendar.
From Select the Calendar Type, select a calendar type.

Shortcut menu An unnamed menu opened with a
right-click. Do not use pop-up
menu, right-click menu, or context
menu. For legacy applications
only.

In the shortcut menu, select Insert Level.

Slider Use move as a verb.
Do not refer to scroll bars or
progress indicators as sliders.

Move the Screen Resolution slider to the right to
increase resolution.
Move the slider to the right to increase screen
resolution.

Tab Tabs usually open pages. Use tab
only if needed.

Click the Security tab.

Text box Use the name of the text box.
Use box only if needed for clarity.

In Email, enter your email.

Tile Do not use. See Card.
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UI Element Usage Example

Toaster Do not use. Instead, use error or
error message.

An error occurs when the file type is not supported.

Toggle (n) Use toggle as a noun only, and
only if needed for clarity.
Use select, switch, turn on, or
turn off as verbs.

To enable the setting, turn on the Data Capture toggle.
Select the Data Capture option.

Tooltip Tooltips should be self-
explanatory, so try not to refer to
them except in specifications.
Do not use flyover, pop-up, or
pop-over.

N/A

View (n) Use grid view or list view, or the
name of the view.

Select the list view to see the accounts in a table.
In the Options view, select a variable.

Wizard A wizard contains individual
pages.

Use the Create an Account wizard to associate a
project.

Verb Syntax for UI Interactions
Use the following verbs to describe the actions associated with UI elements.

Syntax Action Usage

Choose Decide on a preference or desired
outcome.
For UI elements, use click or select
instead.

If you choose to link your data, check that the
data schema is compatible.

Clear Remove the selection of a checkbox or
radio button.
Do not use deselect.

Clear the Header Row checkbox.

Click Click, double-click, and right-click these
elements:

■ Buttons

■ Tabs

■ Shortcuts

■ Icons

■ Links
Do not use click on. Use click in only
when referring to a region that needs
focus.

Click the System tab.
Double-click the lurg65.exe file.
Right-click in the cell and select Format.

Close Stop the following:

■ Dialogs

■ Files and folders

■ Notifications and alerts

Close Excel.
Save and close the document.
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Syntax Action Usage

■ Programs

■ Tabs

Collapse Click to hide a section of navigation or
content. Opposite of expand.

Collapse the Global Navigation pane.

Disable Turn off or deactivate an option or
feature.

Disable the Dark Mode option.

Drag Move something in a user interface.
Do not use click and drag or drag and
drop.

Drag the variable to the new position.

Enable Turn on or activate an option or feature.
When discussing feasibility, use allows
you or lets you.

Enable the mTLS option.
Enable the API for your project.
The report allows you to see the impact of your
changes.

Enter Insert text into a field.
Use type if you provide the exact text or
characters that need to be entered.

Enter a unique name in the Project field.

Expand Click to unhide a section of navigation
or content. Opposite of collapse.

Expand the Variables folder and double-click
Loan to open it in the Project Editor.

Go to Send users in a single step to the
following:

■ Menus

■ Tabs

■ Websites
If multiple steps are needed, use
navigate.

On the ribbon, go to the Design tab.
Go to Example.com to register.

Hover over Hold the mouse pointer over an area of
a screen without clicking to display
helpful information.
Do not use as a noun.

Hover over the account number to see the
owner of the account.

Invoke Start a program or function. Do not use
except in developer guides.
Use run.

Use a Command Prompt window to run the
Export function.

Launch Do not use. Instead, use open. Select Enroll to open a registration form.

Move Transfer an item from one location to
another or adjust a slider up and down.

Move the slider downward to decrease the
volume.

Navigate Send users to a destination that
requires multiple steps.

Navigate to File > Release Project > Product.

Open Act on the following:

■ File Explorer

■ Files and folders

Select File > Release Project to open the
Release Project dialog.
Open the Documents folder.
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Syntax Action Usage

■ Shortcut menus

■ Windows and dialogs.
Do not use invoke, launch, or start.

Press Push a key on a keyboard. Use only for
keyboard commands.

Press Enter to continue.

Select Choose an item from among multiple
items or take action on the following:

■ Checkboxes

■ List items

■ Menu items

■ Radio button options

■ Table rows or columns
Do not use highlight.

Select File > New.
Select the rows that you want to delete.

Switch Move between the options of a toggle
element.

To retain applied filters, switch the toggle to
Pass All Filters.

Turn on, turn off Enable and disable a feature.
Allowed as an alternative to switch.

Turn off automatic highlighting to view your
document more easily.
Turn on the toggle from Turn on high contrast.

Prepositions
When documenting UIs, use the following prepositions.

Preposition UI Element Example

Use in for containers. Dialogs In the Alert dialog, click OK.

Fields In the Name field, enter wsfc-1.

Lists In the Item list, select Desktop.

Menus In the File menu, select Tools.

Panes, panels In the Metrics pane, click New.

Windows In the application window, click Start.

Use from as an alternative to in. Lists From the View list, select Normal.

Menus From the Locale menu, select
English (United States).

Use on for navigational surfaces. Pages On the Create an Instance page,
click Add.

Tabs On the Edit tab, click Save.

Toolbars On the Dashboard toolbar, click
Edit.
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Preposition UI Element Example

Avoid under to describe hierarchical
structure.

Avoid:
Under the File menu, select Tools.

Mock UI
Visualize how UI text is styled and capitalized in the context of generic IRIS
components.

Use title case for the following titles, labels, and menu commands:

■ Button labels

■ Chart titles

■ Dialog box titles

■ Dropdown menu titles
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■ Field titles (both above or to the left of the field)

■ Headings for groups of radio buttons or check boxes

■ Icon labels

■ Links used for an action or navigation

■ Menu items (both menu bar and context menus)

■ Menu titles

■ Page titles

■ Popovers used as labels

■ Section headings

■ Table column headings

■ Tab titles

■ Table titles

■ Tooltips used as labels

■ Window titles

Use sentence case for the following instructions and descriptions:

■ Checkbox items

■ File names

■ Hover help text

■ Input hints

■ Messages (information, warning, and error)

■ Instructions or descriptions on the page

■ Popovers used for instructions

■ Radio button descriptions

■ Status bar text

■ Tooltips used as instructions
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Chapter 7

Specialty Chapters

Specialty chapters for database descriptions, troubleshooting, release notes, FAQs,
glossaries, and indexes have specific requirements.

Addenda
An addendum is a descriptive or reference topic that provides information at the end of
a chapter instead of placing that information in an appendix at the end of the guide.

Using an addendum allows you avoid interrupting the flow of a topic that contains
reference information while keeping the information as close as possible to the topic
that it supports.

Note: The use of addenda is a convention that we reserve for legacy documents.
Do not use addenda in newer product guides.

Examples of addenda content:

■ Documentation about using specific command-line utilities

■ Details about files that are generated when you create a rule maintenance
application

To add a multi-topic addendum, create a container topic with a heading that includes the
word “Addendum,” then nest the subtopics under it. To create a single-topic addendum,
include “Addendum” in the topic title. Add the addendum topic at the end of the other
Heading 1 equivalents in the chapter map.

Fair Isaac Corporation Confidential and Proprietary Information 80



Parts
Do not use book parts. When a guide becomes so large that splitting it into parts seems
necessary, split it into separate guides instead.

For example, the TRIAD User Guide is about 700 pages and includes four components.
Divide the components into more manageable guides because some users may only
need to read about a specific area. Some users may only be interested in reading about
“Decision Areas” and others may only need to know about “TRIAD Concepts”.

If you divide a guide, give each new guide a name that suits the content. Do not use
“Part 1” or “Volume 1”.

Note: Structuring documents with parts is a convention that we reserve for legacy
documents. Do not use parts in newer product guides.

Database Descriptions
The source for most database documentation is the corporate Logical Data Model
(LDM), which is maintained using InfoSphere Data Architect (IDA). Use the following
guidelines for writing documentation for database descriptions.

Modelers create LDM entities and attributes in IDA, and tech writers help edit
descriptions of these items. When the LDM is transformed to a physical database, the
entities become database tables and the attributes become table columns. Product
groups that are producing database tables outside of IDA may follow a different
process. This chapter only describes formatting and phrasing conventions; if you have
any questions, see your manager.
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For the purpose of this chapter, tables are referred to as entities, and columns in the
tables are referred to as attributes.

Standard Attributes
The following attributes appear in every database table:

■ ACTIVE_FROM_DT

■ ACTIVE_TO_DT

■ CREATED_BY_MODULE_CD

■ CREATED_BY_USER_ID

■ CREATED_DTTM

■ EFFECTIVE_FROM_DT

■ EFFECTIVE_FROM_DTTM

■ EFFECTIVE_TO_DT

■ EFFECTIVE_TO_DTTM

■ EXTENSION_XML

■ LAST_UPDATED_BY_USER_ID

■ LAST_UPDATED_DTTM

■ ROW_STATUS_CD

■ ROW_VERSION_SEQ

■ TENANT_CD

It is recommended that these be documented once at the beginning of each database
reference guide or book, rather than documented in every table that appears in the
guide or book. For example:
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Ignore the following standard attributes, because they have been deprecated from the
data model:

■ CREATED_BY_PROCESS_XID

■ CREATED_BY_PROVIDER_ID

■ CREATED_BY_SYSTEM_ID

■ IP_ADDRESS_XID

■ LAST_UPDATED_BY_MODULE_CD

■ LAST_UPDATED_BY_PROCESS_XID

■ LAST_UPDATED_BY_PROVIDER_ID

■ LAST_UPDATED_BY_SYSTEM_ID

Note: The Standard Columns reference topic can be used in database references.
It is located at ProductDocumentation > CommonDataModelAcq > Topics in
TDX.
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Standard Columns
The following columns are frequently used in database tables.

Column Name Name Data Type/Size Description

ACTIVE_FROM_DT Active From Date The first (start) date that
the row is considered
active. Used with an
optional
ACTIVE_TO_DT to
define the date range in
which the row is active.
Cannot be null.
The system database
default value is the
current date. At any
point in time, there can
only be a single row,
with a specific time
period in which it is
considered active. For
example, a product
offering could be
considered active
between July 1 and
August 31 of 2010.

ACTIVE_TO_DT Active To Date The last (end) date that
the row is considered
active. Used with an
ACTIVE_FROM_DT to
define the date range in
which the row is active.
The row remains active
for all time beyond any
ACTIVE_FROM_DT, or
until defined.
The system database
default value is
9999-12-30.

CREATED_BY_MODUL
E_CD 

Created By Module
Code

The code representing
the internal code
module responsible for
the data, which may be
a FICO group (for
example, Fraud or
Originations), a FICO
product (for example,
Debt Manager), or a
subcomponent of a
product (for example,
Debt Manager Promise
to Pay).

CREATED_BY_USER_I
D 

Created By User Id The validated identifier
of the user that created
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Column Name Name Data Type/Size Description

the row. Populated by
the system.

CREATED_DTTM Created Date Time The date and time the
row was created.
Populated by the
system.

EFFECTIVE_FROM_D
T 

Effective From Date The first (start) date that
the row is effective
(active). Used with an
optional
EFFECTIVE_TO_DT to
define the date range in
which the row is
effective.
The system default
database value is the
current date. At any
point in time, there may
be multiple rows for the
alternate key, each with
a different effective from
date. The row
considered current is
the one with the highest
effective from date that
is equal to or lower than
the current date or
supplied target date.
For example, the
current home address
of a customer is the one
in the row with the most
recent
EFFECTIVE_FROM_D
T before or equal to the
current date. When
used,
EFFECTIVE_FROM_D
T becomes part of the
alternate key, and
therefore cannot be
null.

EFFECTIVE_FROM_D
TTM 

Effective From Date
Time

The first (start) date/
time that the row is
effective (active). Used
with an optional
EFFECTIVE_TO_DTTM
to define the date/time
range in which the row
is effective.

Chapter 7: Specialty Chapters

Fair Isaac Corporation Confidential and Proprietary Information 85



Column Name Name Data Type/Size Description

The system database
default value is the
current date/time. At
any point in time, there
may be multiple rows
for the alternate key,
each with a different
effective from date/time.
The row considered
current is the one with
the highest effective
from date/time that is
equal to or lower than
the current date/time or
supplied target date/
time. For example, the
current balance of an
account is the one in
the row with the most
recent
EFFECTIVE_FROM_D
TTM before or equal to
the current date/time.
When used,
EFFECTIVE_FROM_D
TTM becomes part of
the alternate key, and
therefore cannot be
null.

EFFECTIVE_TO_DT Effective To Date The last (end) date that
the row is effective
(active). Used with an
EFFECTIVE_FROM_D
T to define the date
range in which the row
is effective. The row
remains effective
indefinitely or until the
date defined by
EFFECTIVE_TO_DT.
The system database
default value is
9999-12-30.
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Column Name Name Data Type/Size Description

EFFECTIVE_TO_DTTM Effective to Date Time The last (end) date/time
that the row is effective
(active). Used with an
EFFECTIVE_FROM_D
TTM to define the date/
time range in which the
row is effective. The row
remains effective
indefinitely or until the
time defined by
EFFECTIVE_TO_DTTM
. The system database
default value is
9999-12-30 00:00:00.

EXTENSION_XML Extension XML Used to support
extension of the data
model using XML.

LAST_UPDATED_BY_
USER_ID 

Last Updated By User
Id

The validated identifier
of the user that last
updated the row.
Populated by the
system.

LAST_UPDATED_DTT
M 

Last Updated Date
Time

The date and time the
row was last updated.
Populated by the
system.

ROW_STATUS_CD Row Status Code The code representing
the lifecycle status of
the row.

ROW_VERSION_SEQ Row Version Sequence The version number of
the row, populated by
the system with a value
of 0 when the row is
created, and
incremented by 1 for
each atomic update
made to the row. Used
for optimistic (non-
exclusive) locking.

TENANT_CD Tenant Code Part of the unique
primary key for many
tables. A code
representing a tenant
(an entity comprising
multiple clients, a single
client, or an
organizational unit
within a single client).
Tenants can share
pooled resources such
as analysts, queues,
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Column Name Name Data Type/Size Description

cases, accounts,
customers, and
rulesets. The tenant
concept also serves as
a hard data partitioning
(stripe) mechanism in a
hosted environment.

Items That Are No Longer Used
For entities and attributes that are no longer used, deprecated, or slated for removal
from the data model, use the following description: No longer used.

Common Entity Types
The names of particular entities or attributes might be commonly used words that are
defined using lowercase. If the description is clear when these words are lowercase,
maintain this styling, as it will enable other products that use the same table to reuse the
documentation even if they have different specific attributes associated with the table.

For more information, see Using Examples in Entity Descriptions on page 90. Use title
case when referring to the names of particular entities or attributes when items in the
names are proper nouns, or if the definition would be unclear if you used lowercase.

For example:

■ Account Third Party: Associates a third party with an account.

■ Login Audit: Used by the Common Authentication Security Service to record login
attempts for audit purposes.

Note: Proper name.

■ Person: Contains core details about a Person, such as date of birth and marital
status.

Note: Uppercase indicates that we are talking about the Person entity/table,
not just an ordinary person.

If documentation will be fed back into the database (through entry in IDA or directly into
the database fields), character limits may apply, especially if an Oracle database is
used. Spell out cryptic acronyms only if space permits. If adding the spelled-out
acronym causes the description to exceed the limit, move it to the Long Documentation
description of that entity or attribute. (The Long Documentation description contains the
extra text of a description that exceeds the Suggested Documentation character length.)

The following table describes the common phrasing to use for certain entity types and
provides examples. For more information about the domain and non-domain entities
referenced in the table, see Common Domain (Domain and Domain Global
Documentation on page 96.
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Entity Type Phrasing Examples

“Type”
(for entities in the Common
Domain - Domain and Domain
Global packages)

“Defines the list of possible X,
for example, Y (where Y is a list
of example values).”

Account Type: Defines the list
of possible account types, for
example, Customer, Security,
Accounting, Strategy, or Credit
or Debit Card. Can be used to
classify accounts for any reason
other than by product, or to
indicate the reason for
consolidation.
Warrant Status Type: Defines
the list of possible statuses that
can apply to a warranted item,
for example, pending or paid.

“Type”
(for entities in other packages)

“Contains information on a
type…, such as X (where X is a
list of examples of the attributes
contained in the entity).”

Asset Type: Contains
information on the asset type,
such as type description and
subtype code.
An asset type (such as savings
or retirement) is classified by an
asset subtype (such as financial
instrument).
Work Type: Contains
information on the type of work
to be performed by a work team
or work team member working a
case, such as an early
collections call to a customer.
Examples include work type
code, work subtype, queue
priority, and collector
instructions.

"Association" “Associates a Y with a Z.” Customer Scoring: Associates
a score with a customer.
Account Scoring: Associates a
score with an account.
The description provided by a
data modeler may use the terms
“intersection”, “links”, or
“relates”.

"Status"
(for non-domain entities that do
not have a classification, such
as Case and Repossession)

“Contains information on a
status applied to an X, such as
effective date/time and type
code. The list of possible status
values is defined in Y (where Y
is the name of the status type
entity).

Repossession Status: Contains
information on a status applied
to a repossession, such as
effective date/time and status
type code. The list of possible
status values is defined in
Repossession Status Type.
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Entity Type Phrasing Examples

One or more statuses may be
applied, although only one is
active at any one time. The
effective date/time indicates
which status is current and can
be used to determine the status
history.”

One or more statuses may be
applied, although only one is
active at any one time. The
effective date/time indicates
which status is current, and can
be used to determine the status
history.

“Status”
(for non-domain
entities with a
classification, such
as Asset and
Customer)

“Contains information on a
status applied to an X, such as
effective date/time. Statuses are
distinguished by classification.
The list of possible status values
within a classification is defined
in Y (where Y is the name of the
classification status type entity).
One or more statuses may be
applied, although only one is
active at any one time. The
effective date/time indicates
which status is current for a
classification, and can be used
to determine the status history.”

Asset Status: Contains
information on a status applied
to an asset, such as effective
date/time.
Statuses are distinguished by
classification. The list of possible
status values within a
classification is defined in Asset
Classification Status Type.
One or more statuses may be
applied, although only one is
active at any one time. The
effective date/time indicates
which status is current for a
classification, and can be used
to determine the status history.

"Note" “Contains note information for a
Z, recorded by an operator.”

Note: It is acceptable to state
that notes are generally entered
by an operator who interacts
with the system through a UI.

Case Note: Contains note
information for cases, recorded
by an operator.
Customer Note: Contains note
information for a customer,
recorded by an operator.
Account Note: Contains note
information for an account,
recorded by an operator.

Using Examples in Entity Descriptions
When writing descriptions for entities, try to provide two conceptual examples within the
description.

This can include examples of the attributes in the entity. Do not list specific values of
attributes in an entity description; save this detail for the attribute description. In the
following example, italics indicate attribute values.

Examples

Organization (entity): Contains information specific to a Party that is an Organization,
for example, the primary type of business or legal classification type of the business.

Organization Legal Type Code (attribute): The code representing the Organization
Legal Type, such as Public Limited Company, Private Company, Partnership, or Sole
Trader. Can be used in deciding what legal action to take when recovering debt.
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Note: The one exception to this rule is for the entities in the Common Components
- Domain and Common Components - Domain Value packages; for descriptions
of entities in these packages, including conceptual values is acceptable.

Common Attribute Types
If documentation will be fed back into the database (through entry in IDA or directly into
the database fields), character limits may apply, especially if an Oracle database is
used.

Important: The Style Guide is being completely overhauled, and this topic will be
modified in that process. In the meantime, be sure to follow the new guidelines for
the use of gerunds here: Titles on page 66.

Spell out cryptic acronyms only if space permits. If adding the spelled-out acronym
causes the description to exceed the limit, move it to the Long Documentation
description of that entity or attribute.

The following table describes the common phrasing to use for certain attribute types and
provides examples.

Attribute Type Phrasing Examples (<Entity>.<Attribute>)

"Code"
(as a single
primary key)
(occurs rarely)

“A code representing a
unique identifier for (the) X.”

Entity.Entity Code: A code representing a
unique identifier for the entity.

"Code"
(as part of a
compound primary
key)
(occurs often)

“Part of the unique primary
key, along with Y. A code
representing the Z.”

Contact Method.Contact Method Code: Part of
the unique primary key, along with Tenant Code.
A code representing the method for contacting
the customer, such as by phone or by letter.
Case Note Type.Case Note Type Code: Part of
the unique primary key, along with Tenant Code.
A code representing the type of case note.

"Code"
(when not a
primary key)

“The code representing the
X.”

Note:
Can be a type code, status
code, or other sort of code.
Avoid saying “unique” here.

Customer.Preferred Contact Method Code:
The code representing the preferred method of
contacting the customer, such as by phone or by
letter.
Case Note.Case Note Type Code: The code
representing the type of case note.
Account Status.Account Classification Status
Code: The code representing the status of the
account classification.
Account Type.Current Balance Type Code:
The code representing the type of current
balance for the account.

"Account ID"
(when not a
primary key)

“The system-generated
identifier for the Account.”

Important:

Case.Account Id: The system-generated
identifier for the Account.
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Attribute Type Phrasing Examples (<Entity>.<Attribute>)

The Account ID is system-
generated and is guaranteed
to be unique when it is a
primary key (therefore
guaranteeing search result
accuracy). Because it is not
a primary key here, the
description states that it is
system-generated, not
system-populated.

The Account Reference ID
External is generally client
Account Number data that is
pulled into FICO’s system.
Therefore, you cannot
control that each of these
identifiers is unique.

"ID"
(as a single
primary key)

“System-populated primary
key. A unique identifier for
(the) X (where X is the name
of the entity).”
Omit the word “the” in front of
the entity name when using it
would sound awkward, for
example, when the entity
name is a gerund.

Account.Account Id: System-populated primary
key. A unique identifier for the Account.
Case.Case Id: System-populated primary key. A
unique identifier for the Case.
Case Forwarding.Case Forwarding Id: System-
populated primary key. A unique identifier for
Case Forwarding.

"ID"
(as part of a
compound primary
key)
(occurs rarely)

“Part of the unique primary
key, along with X. An
identifier for the Y.”

Calendar Special Day.Calendar Special Day Id:
Part of the unique primary key, along with
Calendar Code and Tenant Code. An identifier for
the calendar special day.

"YYY.XXX ID"
(when not a
primary key)

“The identifier for the X to
which the Y applies.”
(Or other phrasing which
implies the direction of the
relationship between the two
entities. Avoid the phrase
“used in”, which is vague.)

Foreclosure Status.Foreclosure Id: The
identifier for the foreclosure to which the
foreclosure status applies.
Ccm Queue List Item.Ccm Queue List Id: The
identifier for the queue list to which the queue list
item belongs.
Case Action.Case Id: The identifier for the case
on which action was taken.

"ID External" “The X identifier associated
with Y. Unique to the external
system (where Y is the name
of the entity).”

Important: Avoid the phrase
“The X identifier associated
with Y that is unique to the
external system.”

Account Fraud.Account Reference Id
External: The identifier for the account
associated with the fraud. Unique to the external
system.
Judgment.Case Number Id External: The case
number associated with the judgment. Unique to
the external system.

Note:
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Attribute Type Phrasing Examples (<Entity>.<Attribute>)

If the ID is assigned by FICO software, do not
use “Unique to the external system”; describe
which software component assigns it, as shown
in the following example:

Customer Strategy Execution
History.Workflow Id External: The identifier for
the Debt Manager workflow associated with the
treatment ID for the customer. A unique identifier
assigned by the decision management
component.

“External Code”
and
“External Type
Code”

External Code: “An external
code associated with X.”
External Type Code: If this
pattern fits the attribute, use:
“the type of X associated
with the Y (where Y is the
name of the entity).”

Note: If this pattern does not
fit the attribute, use: “An
external code representing
the type of X.”

Credit Application.Promotion Code External:
An external promotion code associated with a
credit application. Used to request a special offer
associated with a particular promotion.
Address.Rural Route Type Code External: An
external code representing the type of rural route
associated with the address.
Address.Street Type Code External: An
external code representing the type of street
associated with the address.

"Text" “Contains narrative text for
X.”

Customer Debt Manager.Customer Note Text:
Contains narrative text for a customer.
Account Note Text: Contains narrative text for
an account note.

"Name" "The name of the X.” Customer Card.Card Cardholder Name: The
name of the customer owning the card.
Hotlist.Hotlist Name: The name of the hotlist.
Credit Non Monetary.Portfolio Name: The
name of the portfolio segment of the account
base to which a given account belongs.

"Description" "Describes the X." Account Bankruptcy Relationship
Type.Relationship Type Description: Describes
the customer relationship type.
Account.Account Description: Describes the
account.
Case Action Type.Action Type Description:
Describes the action type.

"Flag" “Indicates whether <X
occurs>. 0 = First option
(default). 1 = Second option.”

Country Region.Suppress Daylight Saving
Flag: Indicates whether daylight saving time is
suppressed. 0 = Do not suppress daylight saving
time (default). 1 = Suppress daylight saving time
(use standard time).
Customer.Vip Flag: Indicates whether the
customer should receive special consideration. 0
= Customer should not receive special
consideration (default). 1 = Customer should
receive special consideration.
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Attribute Type Phrasing Examples (<Entity>.<Attribute>)

Note:

■ Do not include the phrase
“or not” in the sentence.

■ Do not include the
enumerated values if the
modeler cannot provide
them.

■ 0 is always negative, and
1 is always positive.

■ Use short sentences.

■ See the examples for
more information.

Message Recipient.Active Flag: Indicates
whether the adaptive analytics item is active. 0 =
Item is not active (default). 1 = Item is active.

Note:
List 0 as the default unless the Default Value
column in the Attribute tab of the spreadsheet
indicates 1 is the default.

Role.Role Mutable Flag: Indicates whether the
role can be altered by the client. 0 = Role cannot
be altered. 1 = Role can be altered (default).

“Date Time” “The date and time the X
was Y.”

Account Note.Account Note Date Time: The
date and time the account note was created.

"Language" “A two-character alpha code
representing the language
used for X, as defined by the
ISO 639 standard. For
example, en represents
English. Refer to
LOCAL_LANGUAGE.”

Locale.Language Code: A two-character alpha
code representing the language used for the
transaction, as defined by the ISO 639 standard.
For example, en represents English. Refer to
LOCAL_LANGUAGE.

"Currency" “A three-character code
representing the currency
used in X, as defined by the
ISO 4217 standard. For
example, USD represents
United States Dollars. Refer
to ISO_CURRENCY.”

Offer.Currency Code: A three-character alpha
code representing the currency used in the offer,
as defined by the ISO 4217 standard. For
example, USD represents United States Dollars.
Refer to ISO_CURRENCY.

"Country" “A code representing the
country of the X, as defined
by the ISO 3166 standard.
One of the three ISO
notations may be used. For
example, USA, US, and 840
represent the United States
of America. Refer to
ISO_COUNTRY."

Account Travel Itinerary.Country Code: A code
representing the country of the itinerary, as
defined by the ISO 3166 standard. One of the
three ISO notations may be used. For example,
USA, US, and 840 represent the United States of
America. Refer to ISO_COUNTRY.

"Country Region" “A code representing the
major geographic region
within a country. For
example, the state in the
USA, province in Canada, or
territory in Australia.”

Address.Country Region Code: A code
representing the major geographic region within a
country. For example, the state in the USA,
province in Canada, or territory in Australia.
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Attribute Type Phrasing Examples (<Entity>.<Attribute>)

"Time Zone" “The seeded, numeric code
representing the time zone in
which the Customer is
located, for example, 55 =
Asia/Kolkata and 75 =
Europe/Athens.”

Customer Debt Manager.Time Zone Code: The
seeded, numeric code representing the time zone
in which the customer is located, for example, 55
= Asia/Kolkata and 75 = Europe/ Athens.

"Locale Code" “A code representing the
language and locale of the X,
represented by a
concatenation of the ISO 639
language code and ISO 3166
country code. For example,
en-US represents United
States English.”

Data System.Message Log Locale Code: A
code representing the language and locale of the
message log, using a concatenation of the ISO
639 language code and ISO 3166 country code.
For example, en-US represents United States
English.

"Sequence" “The position of an X within a
Y sequence.”

Account Hierarchy.Child Account Sequence:
The position of a child account within a display or
processing sequence. Used when a parent
account has multiple children.
Address Type.Display Sequence: The position
of the address type within a display sequence.

"String" “Contains the Y.” or “Text
containing the Y.”

Login Attempt.Failure Reason String: Contains
the failure response to a login attempt.
Action Id String: Identifies the action taken by a
user.

Using Examples in Attribute Descriptions
Try to provide two attribute value examples within attribute descriptions.

A single example may be sufficient in some cases. If seed data values or other specific
values are available, use these, and keep them title case; otherwise, the examples can
be lowercase.

Examples

■ (One Value Sufficient) Tms Resource Data.Language Code: A two-character alpha
code representing the language used for the transaction, as defined by the ISO 639
standard. For example, en represents English. Refer to LOCAL_LANGUAGE.

■ (Specific Values) Party Address.Address Type Code: The code representing the
type of the Address, for example Home Address, Work Address, Registered, and
Holiday Address.

■ (General Values) Party Email.Email Usage Code: The code representing how the
address is used, for example, for correspondence or billing.

Check with the data modeler for your product team to find out whether there are seed
data values.
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Common Domain (Domain and Domain Global
Documentation)

Common Domain - Domain and Common Domain - Domain Global entities and
attributes follow a special pattern. These items define options that can be used many
times (for example, in multiple places in the user interface).

By using the domain or domain global entities, you only need to enter the items in the
database and document them one time, rather than each time the options are used.

Entity documentation uses the following pattern, for both domain and domain global
entities: “Defines the list of possible X.”

For each table, only one attribute is documented: the [Entity Name] Type Code attribute.
Attribute documentation uses the following pattern:

Domain: “Part of the unique primary key, along with Tenant Code. A code representing
the Y.”

Domain Global: “The unique primary key. A code representing the Z.”

The following is an example of documentation for the Common Domain - Domain and
Common Domain - Domain Global entities.

Package
Entity
Name Label

ENTITY
DOCUMENTATION

TYPE CODE
ATTRIBUTE
DOCUMENTATIO
N

Common Domain -
Domain

Area Unit AREA_UNIT Defines the list of
possible area units that
can be used for
measurements, for
example, square feet or
square meters.

Part of the unique
primary key, along
with Tenant Code.
A code
representing the
area unit type.

Common Domain -
Domain

Length Unit LENGTH_UNIT Defines the list of
possible units that can
be used for length
measurements, for
example, feet or
meters.

Part of the unique
primary key, along
with Tenant Code.
A code
representing the
length unit type.

Common Domain -
Domain

Account
Score Type

ACCOUNT_SCO
RE_TYPE

Defines the list of
possible Account Score
Types, such as FICO
Cycle score type 1, or
Potential Fraud score
type.

Part of the unique
primary key, along
with Tenant Code.
A code
representing the
account score type.

Common Domain -
Domain

Customer
Score Type

CUSTOMER_SC
ORE_TYPE

Defines the list of
possible Score Types
that can be used for a
Customer Score, for
example a behavioral
score type.

Part of the unique
primary key, along
with Tenant Code.
A code
representing the
customer score
type.
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Package
Entity
Name Label

ENTITY
DOCUMENTATION

TYPE CODE
ATTRIBUTE
DOCUMENTATIO
N

Common Domain -
Domain Global

Decision
Area Type

DECISION_ARE
A_TYPE

Defines the list of
possible Decision
Areas that may apply to
a decision.

The unique primary
key. A code
representing the
decision area type.

Common Domain -
Domain Global

Business
Calendar
Status Type

BUSINESS_CAL
ENDAR_STATUS
_TYPE

Defines the list of
possible business
calendar status types,
either active or inactive.

The unique primary
key. A code
representing the
business calendar
status type.

Common Domain -
Domain Global

Special
Date Type

SPECIAL_DATE
_TYPE

Defines the list of types
that can apply to a
special date, for
example, working date
or non-working date.

The unique primary
key. A code
representing the
special date type.

Troubleshooting Topics
Troubleshooting topics contain information about the symptom, cause, and solution to a
problem experienced by users. Begin troubleshooting topics with a short description that
succinctly describes the symptom, followed by more detailed information about the
problem when available.

The following sections are recommended for troubleshooting topics. Troubleshooting
topics can also be formatted in tables.

Section Title Section Description

None (Contained in the short description) A clear explanation of the symptom, including any
associated error messages.

Cause The reason the problem is happening. When the
cause is not known, indicate "Unknown".

Action The steps the user should follow to resolve the
problem.

Severity (Optional) If known, the severity of the issue may
be included.

The following example is a troubleshooting topic that uses sections.
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Release Notes
Release notes provide an abbreviated list of new features and enhancements in a
minimalistic and consistent presentation.

When a new feature is introduced, try to include links to related topics in the guide
where the feature is fully explained. Release notes are never created for the first
customer-facing release of a product.

Note: These standards apply to North Star documentation and other cloud
documentation where possible.

Guidelines
■ Title and Placement. In the first chapter of the user guide for a product or capability,

include a topic titled "Release Notes" (not "What's New"). In the title, avoid adding
the product name or version number.
If a documentation set includes more than one customer-facing guide and release
notes affect functionality in more than the user guide, include a “See Also” note in
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the “Release Notes” topic of the user guide to refer the user to more information.
See Example 6: See Also Notes in Release Notes on page 103.

■ Introductory Paragraph. Use the following introductory paragraph, followed by a
bulleted list of new features and enhancements:
"This release includes the following updates:”
Exception: If this release includes only one item (a new feature or enhancement),
use the following introductory paragraph instead followed by the bulleted item:
"This release includes the following update:”

■ Links to Topics. For each feature or enhancement in the release notes, follow the
brief description whenever possible with a link to a topic in the user guide that
provides additional details.

■ Multiple Components Updated in a Release. If a release includes updates to
multiple components, format the release notes with a single introductory statement,
followed by sections for each component. See Example 1: Sections for Multiple
New Features.

■ Multiple Guides Affected by Release Notes.If more than one guide for a product is
affected by Release Notes, for example an API guide, add a reference to the user
guide in the other guide.

■ Deprecation Notices. If a function is deprecated as of the current release and will
not be available in future releases or if a function was deprecated in a prior release
and will be removed in the next release, provide that information at the bottom of
the release notes chapter in a separate section titled “Deprecation Notices.” See
Example 5: Deprecation Notices.
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What to Avoid
There are several things to avoid when creating release notes.

■ Avoid release-specific verbiage:

- Avoid nesting the Release Notes topic too far down in the first chapter of the
guide.

- Avoid “in this release” or “in previous releases.”

- Avoid “now.” This term is not required when describing new features or functions.

- Avoid “user” or “customer.” Use “you” instead.

- Avoid overusing product names.

■ Avoid repeating the name of the product.

■ Avoid product or component overviews and a list of benefits.

■ Avoid support case numbers and Jira numbers.

■ Avoid lengthy descriptions of new features or enhancements. Keep release notes
brief and provide additional details in a related chapter or topic.

■ Avoid mentioning features or limitations from previous releases. Instead, make
statements that are true only for the current state of the release.

- Recommended: Extract, transform, and load (ETL) resource configuration has
been added for ETL jobs with resource assignment. This optimizes job execution
to meet performance goals.

- Not recommended: Extract, transform, and load (ETL) resource configuration was
not previously available. It has now been added for ETL jobs with resource
assignment. This optimizes job execution to meet performance goals.

- Not recommended: Extract, transform, and load (ETL) resource configuration was
not working properly in prior releases. It has been fixed and it now optimizes job
execution to meet performance goals.

■ Avoid the term “known issues” in external release notes. Known issues are allowed
only in internal documentation. If a release is affected by a known issue that is
confusing or that will be corrected in a future release, provide a tip or workaround in
the external release notes.

- Recommended: Model Configuration editor supports up to 16 characters for
Cache Group Name.

■ In cross-references within a product guide, avoid using the title of the guide. For
example, in the release notes of the Instant Model Execution Service Guide:

- Recommended: See Trigger BATCH Job Execution.

- Not recommended: See Trigger BATCH Job Execution in the Instant Model
Execution Service User Guide.
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Examples
The following examples are a compilation of multiple product guides and are not
intended to be technically accurate or applicable to a specific product. In your actual
release notes, include links to related topics in the user guide where applicable.

Example 1: Sections for Multiple New Features
This release includes the following new features:

Import FICO JSON Decision Tree (FJDT) Models
You can import an FJDT model file exported from Analytic Workbench 4.4.1 and use the
model in your decision service. The model is based on the FJDT 1.7 specification. See
Import FJDT Models.

Enhancement for the Compilation Job Setting
The Compilation Job workspace feature setting used in the Design/Development
environment has been updated:

■ The Compilation Job setting is enabled by default, and uses Kubernetes for
compilation.

■ If the Compilation Job is disabled, in-memory compilation is used.

For more information, see Compile Project and Compilation Jobs in the Workspace
Settings topic.

Function Lifecycle Management (enabled by tenant)
Function Lifecycle Management allows you to move and track functional entry points
through the lifecycle, instead of components or solutions.

If this feature is enabled for your tenant on DMP 3.28, you can create a workspace that
uses Function Lifecycle Management and move functional entry points configured with
Java Object Models through the Design, Staging, and Production environments, and
track revision history and activity using the Manage Lifecycle interface.

For more information, contact Customer Support.

Enhancements for the Decision Modeler Page
Based on customer feedback, the following updates were made to the Projects table:

■ The Name column was renamed to Workspace column .

■ A Solution Name column has been added to display the associated solution.

■ A Lifecycle column has been added to display the type of lifecycle management
used. If the Function Lifecycle Management is enabled for a workspace, the
Lifecycle displays Function. If the workspace uses the default, the column displays
Solution .

For more information, see Manage Workspaces and Projects.
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Example 2: Bulleted List of Features
This release contains the following updates:

■ Introduction of two new REST and gRPC APIs for integration with Decision
Modeler.

■ Integration support for Decision Modeler 3.9.

■ Integration with Platform Observability to capture logs, metrics, and traces.

■ Support for automatic configuration of security policies and Hotlist-Invoker jars in
the DM workspace through a new REST API. This is a limited-internal release
feature.

Example 3: Upgrade Considerations
Considerations for upgrading from a previous version include the following:

■ You must back up and restore the hotlist after the upgrade is complete. For more
information, see Backup and Restore Hotlists.

■ The Hotlist Comments field has been reduced to 128 characters. If the field in a
previous version contains more than 128 characters, the field will be truncated to
the first 128 characters.

Example 4: Issues/Workarounds in KBAs
Note: To avoid overloading the release notes with known issues or workarounds for
edge cases, you can ask your team if they want to put that information in a
knowledge base article (KBA). If so, format the release notes as follows, where the
support email below is an actual link:

Knowledge Base Article

The FICO Customer Self Service Portal contains a Knowledge Base article
(KB0024423) covering known issues in this release. If additional articles are written
after the release, links to those articles will be added to (KB0024423). If you do not have
access to the FICO Customer Self Service Portal, you can request access from your
Portal Administrator or contact FICO Customer Support via email at support@fico.com.

Example 5: Deprecation Notices
Deprecation Notice
The performance metric element is deprecated in this release and will be removed in a
future release
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Deprecation Notice
Some functionality that was deprecated in the prior release (version 1.3.1) remains
available in this release for the convenience of our customers. The following
functionality will be removed in the next release:

■ Support for SVN

■ Process zone feature

Example 6: See Also Notes in Release Notes
This release contains the following updates:

■ Introduction of two new REST and gRPC APIs for integration with Decision
Modeler.

See Also: For more information about the APIs, see the Data Ingestion Service
3.0 API Guide.

■ Integration support for Decision Modeler 3.9.

■ Integration with Platform Observability to capture logs, metrics, and traces.

■ Support for automatic configuration of security policies and Hotlist-Invoker jars in
the DM workspace through a new REST API. This is a limited-internal release
feature.

Q&A
Question Answer

What if I provided release notes in a separate
document or as a separate chapter in a previous
release? Do I have to republish the previous
version?

No. You don't have to change any previously published
release notes. Make the change going forward.

Do the release notes cover information for the
current release only, or are release notes
cumulative?

The release notes chapter contains information for only the
current release. When we move to a doc portal, we might
revisit how release notes are presented.
Older versions of the Release Notes can be stored in the
Product Documentation Archive or in knowledge base articles
in ServiceNow.

If there are considerations about upgrading to this
release, where should I include them?

In the Release Notes chapter, after the list of updates, create
a section titled “Upgrade Considerations,” then list them
there. See Example 2: Bulleted List of Features on page 102.

When and where do I reference a Knowledge Base
Article (KBA)?

If a KBA article contains information that is important to the
customer experience for this release, use that individual
article as the parent article and include links to any other
articles relevant to that release in the parent article. See
Example 4: Issues/Workarounds in KBAs on page 102. The
parent article and the linked articles must all be in the
external knowledge base.
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Question Answer

What if I am asked to provide Release Notes to
someone outside of my scrum team before GA
approval?

Ask the requestor to discuss their need to have this
information with the product manager. If you provide a draft
based on a PM request, add the "Internal Only" watermark on
the PDF.

What if someone from Support requests Release
Notes for a prospect who is not already a customer
of that specific product or capability?

Refer the Support person to the product manager.

Frequently Asked Questions
Frequently asked questions (FAQ) topics are optional. Add them to a publication when
they help the audience better understand new or complex features and practices.

A well devised FAQ topic helps users find information quickly and saves the Customer
Support team valuable time and money.

Options for product document sets:

■ Create a single, independent FAQ topic that covers questions from the entire
product range.

■ Create an FAQ appendix for each document in the set that requires one.
■

Note: The term section in this topic refers to either option.

Use "Frequently Asked Questions" for the title of the parent topic (either the introduction
for a document, or the introductory topic in an appendix). Do not use the abbreviations
F.A.Q. or FAQ in the main title.

FAQ Stuctures
Each question should be answered separately. Related questions and questions with
multiple answers can be grouped together as nested topics or sub-maps.

To avoid repetition, do not add the terms Question and Answer to introduce each FAQ
topic. Instead, use the question as the topic title.

To prepare for adding FAQ topics, do the following:

1 Decide the questions to feature with your team.

2 Decide whether to format the FAQs an appendix or a separate guide.

3 Create each response as a separate reference topic.

4 Create the maps to group related topics in a sub-map, under an introductory topic.

5 Add the maps to your publication.

As a best practice, add FAQ_ as a prefix to the topic name. (The topic name can be
different from the topic title.) Adding this prefix helps you find FAQ topics when you
search the repository.
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Address questions generically at first, then specifically if necessary. This method will
help you decide on the structure of the section.

The following stucture is recommended for each FAQ:

Item Description

1 Reference topic type Add one question per Reference topic type.

2 Title <title> Enter the question as the title of the topic.

3 Short description <shortdesc> (Required) Answer the question.

4 Abstract <abstract> Longer answers can be added to the abstract.

5 Body <refbody> If more space is needed, add the extra information
in the body.

Example:
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Indexes
When authoring in DITA, the same index entries might be used in many output formats,
such as a PDF, a master index of a library, an online information center for a product, or
a cross-product master index.

In most cases, index entries will work in whichever context they are used. There may be
times when entries need to be customized for different uses. For example, you might
want to add a product or environment identifier to help users of an integrated solution
easily find information on a particular topic.

Note: For instructions on indexing in these types of source files, see the following
resources:

■ DITA topics: See the DITA Authoring Guide

■ FrameMaker books: See the Template User's Guide.

For additional information on indexing, see these resources:

■ The Art of Indexing by Larry S. Bonura

■ Chapter 9 of Read Me First! A Style Guide for the Computer Industry, by Sun
Technical Publications
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■ Chapter 18 of The Chicago Manual of Style, 15th Edition

■ Chapter 6 of the Microsoft Manual of Style

Creating Index Entries
Index entries for each topic should be created at the time the topic is written. Before
indexing your document, compile a list of keywords. These can come from a variety of
sources.

If you are revising a document, start with the terms used in the last version. Check the
structure of the previous version of the document before adding new terms to it. The
following are methods for creating a list of keywords:

■ Select important words from section headings.

■ Extract relevant nouns and verbs from the text.

■ Add abstract or general terms that users are likely to search for.

■ Include synonyms or competitors’ terms.

■ Look for key graphics and associated terms.

■ Check Tips and Notes for important terms.

■ Include necessary acronyms or abbreviations.

After compiling a list of keywords, edit the list so that it follows index phrasing
conventions. Keep the list in front of you as you write each topic to ensure that the
document is indexed consistently.

The following steps are recommended:

1 Review what your users want to accomplish with the product and identify the
information that your readers might need to find.

2 Ask yourself, "What words would users use to look up the information?" Use the
words that might help users find the answers to their questions, not just the words
that appear in the text.

3 Add cross-references, but sparingly.

■ Use the term See to create cross-references that help users learn our
terminology.

■ Add information as See also references to help establish the relationships
between pieces of information.

4 Revise and test your index according to the following instructions: Before building
your index in Publication Manager, review the topics to ensure that all topics are
indexed. If time permits, have someone test the index entries before getting the
index edited.

Tip: A quick and easy way to check that a topic has index entries is to preview it.
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Abbreviations and Acronyms in Indexes
Index the full name once if an acronym is preferred and index the acronym by itself,
without the full name in parenthesis.

Approved Avoid

DSA
      See also simulations
      changing link to RMA
      components of
      configuration settings
      configuring Show/Hide settings

DSA (Decision Simulator Application)
      See also simulations
      changing link to RMA
      components of
      configuration settings
      configuring Show/Hide settings

Decision Simulator Application
      See DSA

N/A

Plural vs. Singular
Use the plural form of all main entries that are nouns, except where it is awkward or
illogical to do so.

The following example shows correct use of both plural and singular entries.

decision tables
      creating decision tables
network
      setting up

Capitalization
Lowercase letters should be used for all index and glossary terms, except proper nouns,
acronyms, and special words, such as text in program code, where capitalization may
convey a characteristic of the term.

Covar
      Corr
      PWeight
      Count
      CorrSumProducts
      SampleWeightSum
      UncorrSumProd
      PCount

Prepositions and Articles
Limit the use of prepositions and articles; use gerunds instead. In general, do not use
articles unless required for clarity.

Important: The Style Guide is being completely overhauled, and this topic will be
modified in that process. In the meantime, be sure to follow the new guidelines for
the use of gerunds here: Titles on page 66.
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Approved Avoid

data files
      creating  132
      deleting  133

data files
      creation of  132, 137
      deletion of  133, 138

Verbs
Use a gerund rather than the infinitive or the base present tense form for entries about
actions, processes, or procedures.

Important: The Style Guide is being completely overhauled, and this topic will be
modified in that process. In the meantime, be sure to follow the new guidelines for
the use of gerunds here: Titles on page 66.

Approved Avoid

selecting
      drawing objects  22
      text  147
shapes
      drawing 37
      fitting around text  140

select
      art  255
      text  147
shapes
      to draw 37
      to fit around text  140

Index Entries and Levels
As a general rule, guides that are 40 pages or fewer do not require an index.

A very simple index contains only one level. A two-level index organizes terms by
categories, where appropriate, and represents a more sophisticated organization of the
material.

The first level is called the primary entry and the second level is called the secondary
entry.

The department standard is to use no more than two entry levels. The addition of a third
or fourth level makes the index more difficult to navigate and makes it more likely for
errors to occur when creating the index. Localized indexes can become unreadable with
more than two levels of entries because entry words are often lengthy and must be
hyphenated.

Approved (Two Levels) Avoid (Three Levels)

paragraph formatting
      characters and words  63
      using styles  97

paragraphs
      deleting  72
      formatting  75
          characters and words  63
          using styles  97

Primary Entries
Some subjects require only a primary entry.

Do not use a two-level entry for a single topic. A primary entry with only one secondary
entry should be on a single text line. If the primary entry alone seems misleading,
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rewrite it. In common topics that share some of the same index entries, some of those
might need to be conditionalized.

Approved Avoid

selecting
      drawing objects  22
      text  147
shapes
      drawing 37
      fitting around text  140

select
      art  255
      text  147
shapes
      to draw 37
      to fit around text  140

Use of Adjectives in Primary Entries
Adjectives without related nouns do not provide enough information for a reader.

This rule also applies to noun modifiers (nouns that are being used as adjectives).

Approved Avoid

data
      data files  63
      data records  47

data
      files  63
      records  47

Over-indexing
Do not provide so many entries that they become unusable.

For example, in an API guide containing many commands or function calls, you might
be tempted to index the subheadings under each command. This often results in over-
indexing.

Index only the most relevant occurrences of a word, not every occurrence.

Approved Avoid

ast command  33, 42
ast_process command  44, 49
ast_subvolume command  51, 55

ast command
      attributes  42
      syntax  33
ast_process command
      attributes  49
      syntax  44
ast_subvolume command
      attributes  55
      syntax  51

Under-indexing
Index length depends upon the length of the document and complexity of the
information. Typically, there are three to five index entries per page of text.

Under-indexing does not provide enough specific information to be useful to the reader.

Chapter 7: Specialty Chapters

Fair Isaac Corporation Confidential and Proprietary Information 110



Approved Avoid

reports
      exporting  77
      generating  34
      preformatting  33
      specifying format  31-39
      types of  31-33

reports  31, 35, 39, 77

Sorting Secondary Entries
Avoid beginning a secondary entry with a word that is not a key term.

Whenever possible, reword the secondary entry so that the key term, rather than an
irrelevant introductory word, appears at the beginning of the entry.

Approved Avoid

accounting
      command summary  38
addressing
      naming conventions 52
      virtual network issues  62

accounting
      summary of commands  38
addressing
      conventions for naming 52
      issues for virtual networks  62

Avoiding Redundant Secondary Entries
Check your index for primary entries that are followed by secondary entries having the
same page reference.

In most cases, you can eliminate the secondary entries because a reader will find all the
information on one page. Redundant secondary entries often occur when indexing items
in a table.

Approved Avoid

address fields  123 address fields
      city  123
      name  123
      state  123
      street  123
      zip code  123

Cross-references in Indexes
Cross-reference index entries by creating See and See Also references.

See Using Cross-references in Index Entries in the DITA Authoring Guide for details.
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Using a See Reference
Use a See reference to:

■ Send a reader to another entry when there are so many secondary entries that
repeating them would be unreasonable.

■ Send readers from a broad category to a more specific category.

■ Direct a reader from a term not used in the document to a term that is used as an
index entry.

Using a See Also Reference
Use a See Also Reference when:

■ Sending a reader to related information at another index entry, not the same
reference information under a different entry.

■ Directing a reader to another term that is used as an index entry and provides
additional or related information.

The following example shows proper use of See Also cross-references:

reports
      See also Expert reports  
      pricing  37
      viewing  37

Testing the Index
Generate a PDF or Help file for your topics to view all of the entries in the output.

Use the following guidelines:

■ Meaningful index entries are included for every important term, concept, task, and
technical entity mentioned in each topic.

■ Where appropriate, each primary entry also exists as a subentry under another
primary entry.

■ All technical entities (commands, functions, keywords, APIs, and so on) are
included and labeled to identify the type of entity. For example, do not index
"Execute;" index "Execute Command" instead.

■ Only the lowest-level entries have page numbers or links.

■ All See and See Also references work and link to valid information.

■ If the list of secondary entries seems too long, consider restructuring as two or
more main entries.

■ Check selected topics and then look up the concepts and other key information to
ensure that they can be found using the index.

■ Make sure "index term" does not appear as an index entry.
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Glossaries
Glossaries provide definitions for terms and acronyms so users can understand their
meaning and significance in a product.

Before you add terms to a glossary, consult the Corporate Glossary. If a term is used
differently in a product than the way it is defined in the Corporate Glossary, contact the
Style Committee.

Style Standards for Glossary Terms
■ Write terms as nouns. To describe a verb, consider changing it to a noun. For

example, change allocate to allocation.

■ Use lower case. Only capitalize proper nouns, acronyms, or special words, such as
program code where capitalization conveys a characteristic of the term.

■ Use the singular form of the term unless the word should always be plural. For
example, change account types to account type.

■ Avoid circular definitions. Do not define terms by restating the term. For example:
Avoid: Case Manager: The manager of the case.
Avoid: Workflow: The flow of work.

■ Cross-reference acronyms to the spell-out terms. Create an entry for each
acronym, which is the more likely term to be searched for, then create another entry
for the full term, then link the entries.

■ When terms have more than one meaning, define them generically first , then
define each of the individual uses, separating each unique idea with (number). For
example:
attribute
(1) In a data model, a characteristic or trait of an entity that describes the entity. For
example, the telephone number of an employee is one attribute of that employee.
(2) In case management, the mapping together of discrete values or ranges of
values into a single group. The entire range of values for a variable is divided into
bins for common treatment, such as reporting or weighted scoring.
(3) In scoring, one or more values of a variable that are grouped together for
analysis purposes. For example, the values "Manager", "Director", and "VP" would
be grouped in the attribute "Executive" in the "Occupation" variable.

Cross-References
Include cross-references where appropriate:

■ Type the name of the cross-reference type. Do not use the DITA <x-ref> element
for cross-references in glossary terms. (The high number of automatically inserted
graphics is distracting to users and not all types are supported in output.)

■ Always include a colon. For example, See:, See also:, etc.

■ Add a period. End each definition with a period, even if it is short.

■ Alphabetize referenced terms for each type of cross-reference.

Tip: In your cross-referenced term, be sure to set the outputclass attribute to
no_page_reference so the page number is not included in the output.

Chapter 7: Specialty Chapters

Fair Isaac Corporation Confidential and Proprietary Information 113



Reference Types
Type Use Example

See: Re-directs readers to the full
version of an acronym in the
Corporate Glossary.

PRD
See: production environment.

Also known as: Informs users of alternative
industry standard or
commonly used names for the
term.

■ If the referenced term is in
the glossary, include it as a
live cross-reference.

■ If it is not in the glossary,
type it in, but do not put it in
italics or quotation marks.

co-signer
A person who signs a note to guarantee a loan
made to another person.
Also known as: coborrower, co-debtor, co-
obligator.

See also: Points users to
supplementary or related
information in the Corporate
Glossary, or to an external
link.

activity
One of a series of automated steps within a
workflow needed to complete a business
process.
See also: task.

In contrast to: Points users to another term
in the Corporate Glossary that
is related to, but differs
significantly from, the current
term.

allowlist
A list of entities approved for authorized access
or privileged membership. For example, IP or
email addresses that belong to a particular
"safe" domain.
In contrast to: blocklist.
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Chapter 8

Word Lists

Use the following terms carefully to add clarity and concision.

Technical Terms
The following terms are often used inconsistently. Do not capitalize these terms unless
specifically noted.

■ Amazon Web Services (AWS), then AWS thereafter.

■ back up (v), backup (n, adj)

■ built-in (adj)

■ check in (v), check-in (n, adj). Do not split these terms, such as checking an item in.

■ check out (v), check-out (n, adj). Do not split these terms, such as checking an item
out.

■ cloud (adj). The term "FICO Analytic Cloud" and "FAC" have been deprecated.
Instead, use "FICO cloud".

■ comma-delimited file

■ command line (n), command-line (adj)

■ command prompt. Refer to the window in which the command prompt appears as
the Command Prompt window. When writing about UNIX, Linux, or macOS
systems, the equivalent to a command prompt is Shell window.
Do not use C prompt, command-line prompt, or system prompt.

■ dataset (n)

■ data type (n)

■ dual-access (adj)

■ end user. Do not use.

■ entry level (n), entry-level (adj)

■ explode. Do not use.

■ email (n, v)

■ fixed length (n), fixed-length (adj)

■ floating point (n), floating-point (adj)

Fair Isaac Corporation Confidential and Proprietary Information 115



■ follow up (v), follow-up (adj)

■ in sync, out of sync (adj)

■ internet (lower case)

■ Kubernetes (K8s), then k8s thereafter.

■ lifecycle

■ log in (v), login (n, adj) Do not use log on or logon.

Note: If a product uses log on, sign in or some other variant, use the
terminology in the UI on and notify your development team about the
discrepancy.

■ look up (v), lookup (adj or n)

■ micro-frontend (n, adj)

■ migrate. Use migrate to describe movement, remapping, reformatting, and changing
environments. Do not use for upgrading to a new product version. See upgrade.

■ multitask (v)

■ non-interlaced (adj)

■ non-zero (adj)

■ object-oriented (adj)

■ offline (adv). Do not use off-line.

■ off-premises. Do not use off-premise.

■ on-premises. Do not use on-premise .

■ random access (adj)

■ restart (v)

■ runtime (n, adj)

■ screenshot. Do not use. Instead, use figure.

■ source code (n), source-code (adj)

■ standalone

■ timeframe

■ timestamp

■ toggle (n)

■ toggle (v). Do not use. Instead use switch, turn on, or turn off with the name of the
toggle or command.

■ update. Use to describe the installation of a hotfix or service pack.

■ upgrade: Use to describe moving to a new product version.

■ upload (adj, v)

■ users (n). Do not use end user or the user.

■ user ID (n). Do not use user id, user Id, userid or userId except in code.
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■ web (n, adj)

■ web address

■ web browser

■ web form

■ web page

■ web server

■ web service

■ webmaster

■ website (n)

■ write-enabled (adj)

Preferred Terms
The correct use of the following words and phrases can add clarity.

Above, Below, Beneath
Use above, below, or beneath to reference the location of elements when describing a
user interface.

Do not use above, below, or beneath to refer to other content within a document or
topic.

Do not use above or below to refer to earlier or later software versions.

Note: For details and examples, see Earlier, Previous, Later (Release Versions)
and Previous, Preceding, Following, Next.

Approved
Any rows that are part of the current selection are copied and pasted immediately above
the current selection.

Click the grey shelf area below the blue masthead to open the Scenario Manager.

In the Tree Templates section, beneath the Templates heading, locate the input field
labeled Create a new template.

Avoid
For more, see the table below.

This feature is available in Decision Optimizer version 6.0 and above.
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Allow, Let, Permit, Enable
Avoid let and permit when indicating that a user can perform an operation in a program.
In the sense of enabling a command or making a command available, use allow or
enable. Avoid the use of you with these words.

For example, the sentence “FICO Decision System allows you to create, modify, test,
and execute projects,” can be rewritten as “Use FICO Decision System to create,
modify, test, and execute projects” to avoid the use of you.

Approved
Use the View Menu options to view information in several ways.

Users cannot change the project permissions.

Only the user who created the message can delete it from the system.

Avoid
The View Menu lets you present information in several ways.

The program will not let you change the project permissions.

If you did not create the message, you are not permitted to delete it from the system.

And/Or
For localization reasons, avoid and/or if possible, unless you cannot rewrite the
sentence comfortably in a logical fashion. Use only when there is a clear need to
express the distinction between the and condition (A and B are both true) and the or
condition (only one of them is true).

And/or is considered standard usage for legal documents and content, such as the
copyright information that appears in our manuals. This content is supplied by the
Corporate Legal department.

As a rule, avoid using slashes in documentation. If writing about a UI element label,
such as Show/Hide, use the slash; otherwise do not use it.

Note: In the following examples, and is implied.

Approved
This film is suitable for both children and teenagers.

Select A, B, or both.

When you want the system to find the assemblies or classes, edit the configuration.

Use the Show/Hide feature in Microsoft Word to differentiate between tabs, spaces, and
paragraph returns.

Avoid
This film is suitable for children and/or teenagers.
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Select A and/or B.

When you want the system to find the assemblies and/or classes, edit the configuration.

Double-click on the row to modify/update the information.

Appears, Displays, Opens
Use open for objects the user is opening, such as dialog boxes. For messages or
prompts that the system generates, use displays (a transitive verb which requires an
object) or appears (an intransitive verb which does not require an object). If necessary
in context, use the passive is displayed.

Approved
Click OK to open the Open Project dialog box.

The system displays an error message.

If you try to quit the program without saving the file, a message appears.

Avoid
The system appears with an error message if you do not log in with the correct
password.

If you try to quit the program without saving the file, a message displays.

Champion/Challenger, Champion-Challenger
User lowercase with a hyphen between the two words: champion-challenger.

Choose, Click, Select
Do not use choose in procedures. Use click for buttons, icons, and links. Use select
(and clear) for check boxes, radio buttons, menu items, and where there is more than
one option.

When using click, do not use the words the, button, or on when describing the task.

Note: Clickable is acceptable where appropriate.

Approved
Click Save.

Select File > Project Contents > Administration Tools.

To delete a status, select the check box next to the row and click Delete.

Avoid
Click the Save button.
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Choose File > Project Contents > Administration Tools.

To delete a status, mark the check box next to the row and click Delete.

CLASSPATH, classpath
When describing the specific variable, use CLASSPATH. If you are writing about the
concept, use classpath.

Approved
Use addenvvar or chgenvvar to update the CLASSPATH variable.

Before you can import Java classes, you must set the classpath to the classes.

Avoid
Before you can import Java classes, you must set the ClassPath to the classes.

Complete, Perform
Use perform instead of complete when writing procedures. Perform is always a verb,
whereas complete can be an adjective or a verb.

Approved
Perform a backup of the database before the installation.

Avoid
Complete the following steps to narrow down the list.

Comprise, Compose
Because the meaning of comprise and compose is often confused, avoid these two
words altogether and use a synonym. Comprise means include, contain, or enclose.
Compose means to make up, consist of, or constitute.

Approved
FICO Decision System consists of core applications, auxiliary tools, and utilities.

FICO Decision System includes four core applications: Designer, Projects Explorer,
Runtime Server Applet, and Porting Requester.

Avoid
FICO Decision System is composed of core applications, auxiliary tools, and utilities.

The whole is comprised of the parts.
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Configuring, Defining, Mapping, Setting Up
Do not use setting up when describing how to configure or set up a system; use
configuring instead. Use defining instead of configuring to describe how to define a rule
or characteristic. Use mapping for topics about field mapping.

Approved
Configuring Publication Manager

Defining Business Rules

Mapping Field Properties

Avoid
Setting up Publication Manager

Configuring Business Rules

Setting Field Properties

Creating, Modifying, Editing, Updating
Start procedural headings with a gerund, such as Creating or Modifying. Do not use
Editing in procedural headings. Use Updating only when the action or task is something
different than modifying.

Important: The Style Guide is being completely overhauled, and this topic will be
modified in that process. In the meantime, be sure to follow the new guidelines for
the use of gerunds here: GUID-62B15729-D52F-406B-9795-E0F0AAA49B56.xml.

Approved
Modifying Tables

Avoid
Updating Tables

Delete, Remove
Do not use remove to mean delete. Use remove when writing about removing a program
or items in programs to customize an interface. Use delete when writing about the
Delete command and as an imperative in procedures.

Approved
To delete a Hotlist, click the Delete Hotlist icon.

Use the Add/Remove Programs option to change or remove a program in Windows XP.

Avoid
To remove a Hotlist, click the Delete Hotlist icon.
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Use the Add/Remove Programs option to change or delete a program in Windows XP.

Directory, Folder
Use folder when writing about Windows products and environments. Use directory when
writing programming documents or documenting specific references to the structure of a
file system, such as MS-DOS or UNIX environments.

The exception to this rule is when the UI contains the word directory; for example,
Directory Path as a field name.

Earlier, Previous, Later (Release Versions)
To refer to one or more preceding versions of a product, use earlier or previous instead
of lower or older.

To refer to a specific version of a product, as well as all future versions, use later rather
than higher or newer.

Do not use earlier or later to refer to text mentioned elsewhere in a document.

Approved
As of JDK 11 and later, the Debt Manager Client is supported only on the Windows
platform.

If you are upgrading from Falcon 6.4 or earlier, ensure your hardware is compatible with
Java 11.

If you are upgrading and migrating data from a previous release of Decision Central,
you will need to upload some processes to use them.

Avoid
The application supports Red Hat Enterprise Linux (RHEL) 6.x and lower.

The application supports Red Hat Enterprise Linux (RHEL) 5.x and higher.

You do not need to perform this configuration if you are using a newer version of the
plug-in.

In older versions of Debt Manager, this report was included as a section of the Entity
Management report.

Note: For related information, see Lower, Higher, Older, Newer and Previous,
Preceding, Following, Next.
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Get, Obtain
Use obtain instead of get when referring to retrieving information.

Approved
The Application Processing Module uses the references to obtain the enumeration
values.

Avoid
The Application Processing Module uses the references to get the enumeration values.

Help, Online Help
Avoid the redundancy of using online, except when necessary to describe the Help
system; in general, use just Help. The terms online Help, context-sensitive Help, and
online Help files are acceptable when necessary to describe the Help system itself or to
explain how to develop a Help system. Help should also be capitalized when used
alone.

When referring to an Information Center, write out the entire word. Do not use
InfoCenter.

Approved
You have easy access to hundreds of subjects in Help.

Avoid
You have easy access to hundreds of subjects in online Help.

Hence, Thus
Use therefore or so in place of hence and thus.

In Which, Where
Use where for location and variables (or other math-related areas). Use Where to
indicate what variables stand for in an unordered list. Do not use where in places where
when or in which are more appropriate.

Approved
The code identifies the bank branch where the debtor's account resides.

The name of the location where the auction is being held.

Promise To Pay is an arrangement in which a customer agrees to make one payment
on a given date.
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Repossession is the process in which a client recovers the asset of a customer due to
delinquency or other contractual violation.

u To add a client from the PMAX_HOME/util directory, enter:$ tenantMgr.ksh -
addClient new_tenant client <config_group>
Where:

■ new_tenant is the name of the tenant to which the client will be added.

■ client is the name of the client to be mapped to the tenant.

Avoid
The name of the location in which the auction is being held.

Promise To Pay is an arrangement where a customer agrees to make one payment on a
given date.

Repossession is the process where a client recovers the asset of a customer due to
delinquency or other contractual violation.

Indicates, Specifies
Indicates and specifies are similar but have different meanings and should not be used
interchangeably.

Use the following guidelines to determine the appropriate word:

■ The definition of indicate is to “suggest the necessity or advisability of”. Use indicate
when the system displays a value resulting from an operation, for example, “The
flashing button indicates that the application has identified a fraudulent claim.”

■ The definition of specify is to “state explicitly or in detail”. Use specify when a user
needs to set or enter a value, for example, “Use the SSNRecentlyIssued parameter
to specify the number of years to use in the check.”

Latin Abbreviations
Latin abbreviations are often confusing to readers and cause difficulties for localization.

Avoid Latin abbreviations except to save space in tables and images.

■ Instead of e.g., use for example.

■ Instead of i.e., use that is.

■ Instead of vs or vs., use versus.

■ Instead of via to mean by way of, use by or using.
Exception: The use of via is acceptable in relation to transportation.

■ Instead of vice versa or vice-versa, find another word or phrase.

■ Instead of etc., rewrite the sentence or use such as, and so forth, or and so on.

Tip: Do not include for example and and so forth in the same phrase as doing
so is redundant.
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Launch, Start
Do not use launch to mean start, as in “launch an application”. Use start instead.

Example
Start the X install wizard.

See: For more information, see Action Syntax for UI Elements on page 75.

Lower, Higher, Older, Newer
To refer to the release history of software, use earlier or later instead of lower, higher,
newer, and older.

For related information, see Earlier, Previous, Later (Release Versions) and Previous,
Preceding, Following, Next.

Multi-tenant, Multi-tenancy
Use multi-tenant as a noun when referring to the multi-tenant functionality. Use multi-
tenancy as an adjective when describing multi-tenant features.

Once, After
Do not use the word once as a synonym for after or when.

Approved
After you build the project, the Add/Remove from Memory dialog box opens.

Avoid
Once you build the project, the Add/Remove from Memory dialog box opens.

Out-of-the-box
Do not use out-of-the-box. Use preconfigured or standard configuration instead.

Previous, Preceding, Following, Next
Because the placement of text may change based on the device or reading method
used, do not use above, below, or similar directional information to refer to other content
within a document or topic.

When referring to material that has already been discussed in a topic, use previous or
preceding.

When referring to material that occurs later in the same topic, use following or next.

Chapter 8: Word Lists

Fair Isaac Corporation Confidential and Proprietary Information 125



If the material appears in a different topic, use a cross-reference.

Approved
The following table describes the icons.

The symbols described in the preceding paragraph are enclosed within brackets and
can be repeated an arbitrary number of times.

Use the procedure described in the next section to configure the job steps.

Avoid
For information about creating user IDs, see above.

The table above provides the default roles and permissions for users.

The figure below illustrates the relationship between the variables.

Prompt
Do not use prompt as a noun, except when using the term command prompt, or if the UI
you are documenting heavily refers to prompts (as in BusinessObjects). Use it as a verb
to mean that the system is requesting information or an action from the user. Use
message or error message instead.

Approved
After the process is complete, a command prompt appears.

During the installation, you are prompted to insert disks one by one.

Avoid
If you receive a prompt that the setup is incomplete, make sure all fields contain
information.

Note: For more information, see Technical Terms.

Right-click Anywhere in the White Space
Do not use right-click the white space in a topic. Use right-click anywhere in the white
space instead.

Do not use in, on, or the immediately after right-click or right-clicking. This scenario
frequently occurs when the user needs to right-click on an open area to activate the
shortcut menu.

Approved
Right-click anywhere in the white space and select New Strategy from the shortcut
menu.
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Avoid
Right-click white space and select New Strategy from the shortcut menu.

Right-click the white space and select New Strategy from the shortcut menu.

Right-click in white space and select New Strategy from the shortcut menu.

Right-click in the white space and select New Strategy from the shortcut menu.

Right-click on the white space and select New Strategy from the shortcut menu.

Since, Because
Avoid using since to mean because.

It is a localization problem and in some cases, it can result in ambiguity. Use because to
refer to a reason and since to refer to a passage of time. If it is possible to misinterpret
the meaning of since as referring to a reason, rewrite the sentence.

Approved
Because I installed the cable modem, I can download messages very quickly.

Since installing the cable modem, I can download messages very quickly.

Avoid
Since I have the faster modem, I will download the file.

Use, Utilize
Do not use utilize; write use or another appropriate synonym instead.

Utilize means using something in a way in which it was not meant to be used, but in
technical and business writing, it has become a synonym for the clearer and more
concise use.

Approved
Some applications are unable to use expanded memory.

If a form contains many fields that use the same information, repeat the information with
the ASK and REF fields.

Avoid
The models utilize the input data associated with each new event.
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Validate, Test
Do not confuse the different meanings of validate and test . Use test when writing about
determining the quality of an item and validate when writing about the confirmation or
approval of something.

Examples
Validate a work queue definition while creating or modifying it to avoid problems later
on.

Run a report to test the effectiveness of the new rule.

ZIP Code, Postal Code
Use the generically international postal code in text. Avoid using ZIP Code unless the UI
being documented contains a “Zip Code” field (and then speak with Development to
have it changed)

Prohibited Terms
Avoid the following terms, some of which can have offensive connotations.

Prohibited Term Allowed Term Definition

master primary In an electronic interaction, the device that acts as the
controller and initiates the commands for the other
("secondary") devices.

slave secondary In an electronic interaction, one or more devices that
respond to the commands of the controlling ("primary")
device.

blacklist blocklist A list of domains, email addresses, IP addresses, or
other identifiers for which delivery of emails or other
computer access is blocked.

whitelist allowlist A list of entities approved for authorized access or
privileged membership. For example, IP or email
addresses that belong to a particular "safe" domain.

black hat unethical When referring to a hacker, a person who attempts to
find computer security vulnerabilities and exploit them
for personal financial gain or other malicious reasons.

white hat ethical When referring to a hacker, a computer security
specialist who intentionally tries to break into protected
systems and networks to test and assess their security.

blackbox (or "black
box") testing

behavioral testing A software testing method in which the internal
structure, design, or implementation of the item being
tested is not known to the tester.

whitebox (or "white
box") testing

structural testing A software testing method in which the structure,
design, or implementation of the item being tested is
known to the tester.
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Prohibited Term Allowed Term Definition

DMP Manager UI Never refer to DMP Manager UI in user-facing
documentation.
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Appendix A

Revision History

The following changes have been made to this guide since the last release.

Date Initials Issue #
Chapter/
Appendix Change

August 2024 PBJ TPI-893 Various Updated links based on an external
dependencies report. There were some
unexpected broken links in addition to Box link
changes.

EG TPI-784 Glossaries Streamlined chapter. Removed procedural
information.

August 2025 AB, JJ,
PBJ, VM

Introduction ■ Removed CMOS the Web Style Guide as a
reference.

■ Added the Google Style Guide for APIs, and
Write the Docs, and N-Gram Viewer for
general writing guidance.

General
Principles

■ Added the General Principles chapter to
contain a handful of topics that did not fit
anywhere else.

■ Added a new Accessibility topic.

■ Condensed the Copyrights and Trademarks
chapter into a single topic, and updated the
topic to reflect the Legal requirement to
trademark product names at first mention in
every topic.

■ Added a new Customer Support topic to
reflect the name change.

■ Added a new Error Messages topic that
points to the Confluence page that is the
single source of truth.

■ Replaced all topics related to localization and
global audience with a cross-reference to the
Confluence page that is the single source of
truth.
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Date Initials Issue #
Chapter/
Appendix Change

■ Added a new Timelessness topic to explain
the need to keep our docs applicable to a
single release.

■ Added a new Tone topic (formerly called
Voice and Tone on the UX experience site).

Language and
Grammar

■ The reorganized chapter now contains the
following topics:

- Abbreviations, with revised guidelines for
first mention of acronyms to exclude
headings, and to clarify that the spelled-out
acronyms are not always capitalized.

- Anthropomorphisms, with guidelines about
how to avoid them.

- Articles.

- Capitalization, with new guidelines for
headings and guidelines to capitalize the
second word in hyphenated terms in
headings.

- Context, to emphasize the need to situate
a reader in the UI before telling them what
to do).

- Contractions.

- Gerunds.

- Plurals in Parentheses.

- Possessives, to clarify the use of its and
it's.

- Prepositions, with guidelines about using
them to break up noun strings.

- Pronouns (to clarify the use of "you" and
"the user"),

- Relative Pronouns, to disambiguate the
use of that and which.

- Verb Tense, to emphasize the use of
present tense.

■ Some of the topics related to formatting were
moved to the new Format chapter.

Format and
Structure
(formerly
Organization
and Structure)

■ Topic Titles and Introductory Text was
merged with parts of Captions for Figures
and Tables and edited for brevity. Other parts
of the Captions topic were merged with
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Date Initials Issue #
Chapter/
Appendix Change

Titles. Added a new subtopic called Run-in
Headings.

■ A new Dates and Time topic was added.

■ Graphics, Figures, and Figure Captions were
merged and edited for brevity. Much of the
content about graphics was moved to the
DAG. Table and figure captions are now
optional.

■ Added a new Footnotes topic.

■ Added a new Examples topic.

■ Added a new Italicized Words topic.

■ Added a new Keystrokes topic.

■ Added a new Numbers topic.

■ Added a new Paragraphs topic.

■ Troubleshooting, Parts, and Addenda topics
were moved to the Specialty Chapters
chapter.

■ Moved much of Procedures" topic to DAG.
Edited the retained content for clarity.

■ Updated Short Descriptions to clarify best
practices and add examples.

■ Updated Lists to clarify best practices.

■ Updated links to error message guidelines.

Punctuation
(formerly
Capitalization,
Punctuation,
and
Hyphenation

■ Capitalization Basics and its subtopics were
combined into a single Capitalization topic.
Capitalization rules are simplified.

■ Added new topics for each type of
punctuation: Colons, Commas, Dashes,
Ellipses, End Punctuation, Exclamation
Points, Hyphens, Parentheses, Question
Marks, Quotation Marks, Semicolons, and
Slashes.

■ The second word of compound words are
now capitalized in titles.

■ En-dash and em-dash use has been clarified.

■ Guidelines for hyphens has been simplified.
Lists of hyphenated words were removed in
favor of consulting a dictionary or the
corporate glossary.
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Chapter/
Appendix Change

User Interfaces ■ Incorporated guidelines from the UX
standards produced by the Product Design
team.

■ Clarified the names and use of IRIS widgets
and other UI components.

■ Added a graphic to illustrate capitalization
rules.

Specialty
Chapters

This new chapter contains existing topics for
Database Descriptions, Troubleshooting,
Release Notes, FAQs, Indexes, and
Glossaries, all of which explain how to create
specific types of chapters. This information
needs to be moved to the DAG.

Word Lists Various glossaries were moved to this chapter.
The contents will be updated in the future.

Glossary The Corporate Glossary has been removed
and replaced with links where appropriate. Part
of the content from the Words List chapter will
probably be moved to this chapter in the future.
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Index

Symbols
-ing endings 23
(s) 24

A
a, an, the 20
abbreviations 18
accessibility 9
acronyms 18
addenda 80
adjectives 31
alt text 47
anthropomorphism 20
articles 20

B
backslash 40
blank cells 65
branding 16

C
callouts 47
camel case 21
capitalization

hyphenated words 21
in headings 21

captions (figure titles) 42
caution 52
code snippets 65
column headings 65
components 42
conjunctions 31
content references (conrefs) 43
contractions 23
copyrights 12
cross-references 43
customer support 14

D
dashes 34
database

references
attribute examples 95
entity examples 90
standard columns
ACTIVE_FROM_DT 84
ACTIVE_TO_DT 84
CREATED_BY_MODULE_CD 84
CREATED_BY_USER_ID 84
CREATED_DTTM 85
EFFECTIVE_FROM_DT 85
EFFECTIVE_FROM_DTTM 85
EFFECTIVE_TO_DT 86
EFFECTIVE_TO_DTTM 87
EXTENSION_XML 87
LAST_UPDATED_BY_USER_ID 87
LAST_UPDATED_DTTM 87
ROW_STATUS_CD 87
ROW_VERSION_SEQ 87
TENANT_CD 87
tables 96
attributes 82
common attributes 91
deprecated items 88
entities 88

database references 81
database tables 81
dates 45
definitions 48
diagrams 47
domain global

database
tables 96

dots 35

E
ellipsis 35
em dash 34
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en dash 34
ending prepositions 25
error messages 14
et cetera 35
exclamation points 36

F
FICO products 34
figures

writing titles 42
flowcharts 47
footnotes 65
format 42
forward slash 40
future tense 28

G
gerunds 23, 66
glossaries

writing terms 113
graphics 47

H
headings 66
hyphens 36

I
icons 47
images 47
important 52
index

capitalization 108
cross-references 111
plurals 108
resources 106
testing 112

initialisms 18
instructions 23
introductory phrases 31
introductory sentences 58
ISO standard for dates 45
italics 48

L
latin abbreviations 124
link labels 43
lists 49
Lucidchart 47

M
modifiers, use of 14

N
negative numbers 36
note 52
note types

caution 52
important 52
note 52
see also 52
tip 52

numbers 54

P
page numbers 43
paragraphs 56
parts 81
plurals 24
possessives

inanimate objects 20
prefixes 36
prepositions 25
procedures 58
pronouns 26
providing context for 23
punctuation

colons 31
summary 29

Q
quotation marks 38

R
ranges 34
relationship tables (reltables) 43
relative pronouns 27
release notes 98

example 1: sections for multiple new features
101
example 2: bulleted list of features 102
example 3: upgrade considerations 102
example 4: issues/workarounds in KBAs 102
example 5: deprecation notices 102
example 6: see also notes in release notes 103
examples introduction 101
guidelines 98
q&a 103
what to avoid 100

Index
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s in parentheses 24
screenshots 47
see also 52
semicolons 39
sentence case 21
sentences 56
serial commas 31
service marks 12
short descriptions

introduction 63
slashes 40
structure 42

T
tables 65
task titles 58
terminology 115

cloud 115
computer 115
keyboard 48

terminology (continued)
offensive 128
preferred 117
prohibited 128
technical 115

that versus which 27
third-party content 15
time zones 45
tip 52
title case 21
titles 66
tone 16
trademarks 12
troubleshooting topics 97

V
verb tense 28

W
would 28
writing for clarity 56
writing tips 14

Index
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